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Creative Suite 4 Production Premium Read Me 
 
Welcome to Adobe® Creative Suite® 4 Production Premium.  This document contains late-
breaking product information, updates, and troubleshooting tips not covered in the Creative Suite 
4 Production Premium documentation. 
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Uninstall your software 
Purchase from a trial 
Electronic licensing 
Registration information 
Font installation 
Known issues 
Customer care 
Other resources 
Individual product information 
 

Creative Suite 4 Production Premium applications 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4 (offers direct access to Version Cue® and Adobe® Device Central) 
• Adobe Dynamic Link 
• Adobe Media Player 

Minimum system requirements 
 
Windows® 

• 2GHz or faster processor for DV;3.4GHz for HDV; dual 2.8GHz for HD* 
• Microsoft® Windows® XP with Service Pack 2 (Service Pack 3 recommended) or 

Windows Vista® Home Premium, Business, Ultimate, or Enterprise with Service Pack 1; 
(certified for 32-bit Windows XP and Windows Vista†) 

• 2GB of RAM (more RAM recommended when running multiple components) 
• 16.3GB of available hard-disk space for installation; additional free space required during 

installation (cannot install on flash-based storage devices) 
• 1,280x900 display with OpenGL 2.0-compatible graphics card‡ 
• Graphics support for Shader Model 3.0 



 
 

• Dedicated 7200 RPM hard drive for DV and HDV editing; striped disk array storage 
(RAID 0) for HD; SCSI disk subsystem preferred 

• For SD/HD workflows, an Adobe-certified card for capture and export to tape‡ 
• OHCI-compatible IEEE 1394 port for DV and HDV capture, export to tape, and transmit 

to DV device 
• DVD-ROM drive (DVD+-R burner required for DVD creation) 
• Blu-ray burner required for Blu-ray disc creation 
• Microsoft Windows Driver Model- or ASIO-compatible sound card 
• QuickTime 7.4.5 required to use QuickTime features  
• Broadband Internet connection required for online services 

 
*An SSE2-enabled processor is required for AMD systems 
 
† Adobe Photoshop Extended natively supports 64-bit editions of Windows.  Adobe Premiere Pro, 
After Effects, Soundbooth, Encore, and Adobe OnLocation are certified on 64-bit Windows Vista.  
Visit www.apple.com for information about QuickTime compatibility with 64-bit editions of 
Windows. 
 
Mac OS  

• Multicore Intel® processor 
• Mac OS X v10.4.11–10.5.4 
• Java™ Runtime Environment 1.5 required for Adobe Version Cue Server 
• 2GB of RAM (more RAM recommended when running multiple components) 
• 20.6GB of available hard-disk space for installation; additional hard-disk space required 

during installation (cannot install on a volume that uses a case-sensitive file system or on 
flash-based storage devices) 

• 1,280x900 display with OpenGL 2.0-compatible graphics card‡ 
• Some GPU-accelerated features require graphics support for Shader Model 3.0 and 

OpenGL 2.0 
• Dedicated 7200 RPM hard drive for DV and HDV editing; striped disk array storage 

(RAID 0) for HD; SCSI disk subsystem preferred 
• DVD-ROM drive (SuperDrive required for DVD creation) 
• Blu-ray burner required for Blu-ray disc creation 
• Core Audio-compatible sound card 
• QuickTime 7.4.5 required to use QuickTime features  
• Broadband Internet connection required for online services 

 
‡ For updates to system requirements and more detailed information about video hardware 
compatibility, visit www.adobe.com/go/production_systemreqs 
 
This product may allow you to access certain features that are hosted online (“online services”), 
provided you have a high-speed Internet connection. The online services, and some features 
thereof, may not be available in all countries, languages, and/or currencies and may be 
discontinued in whole or in part without notice. Use of the online services is governed by separate 
terms of use and by the Adobe Online Privacy Policy, and access to these services may require 
user registration. Some online services, including services that are initially offered at no charge, 
may be subject to additional fees. For more details and to review the terms of use and Online 
Privacy Policy, visit www.adobe.com. 
 
Install your software 

1. Before you install, close all applications currently running on your system—including 
other Adobe applications, Microsoft Office applications, and browser windows.  It is also 
recommended to temporarily turn off virus protection during the installation process. 
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2. You must have administrative privileges or be able to validate as an administrator. 
3. Do one of the following:  

Windows:  
o Insert the DVD in your drive, and follow the on-screen instructions. If the installer 

does not launch automatically, navigate to the Adobe CS4 folder found at the 
root level on your disk and double-click Setup.exe to start the installation 
process.  

o If you downloaded the software from the web, open the folder, navigate to the 
Adobe CS4 folder, double-click Setup.exe, and then follow the on-screen 
instructions. 

Mac:  
o Insert the DVD in your drive, and follow the on-screen instructions. If the installer 

does not launch automatically, navigate to the application folder found at the root 
level on your disk and double-click Setup Mac OS® to start the installation 
process.  

o If you downloaded the software from the web, open the folder, navigate to the 
application folder, double-click Setup, and then follow the on-screen instructions. 

4. If you are installing as an upgrade, the installer will check your system to find the valid 
upgrade product.  If it cannot find it, it will ask you to input the serial number of the 
product being upgraded.   You can also install the software in trial, then input your new 
and previous serial numbers in the serialization screen shown during launch. 

5. For additional CS4 installation help, go to www.adobe.com/go/cs4install/. 

Known issues 

• On Mac after installation, your system performance may seem slower.  Rebooting 
your system after installation will resolve this.  (#BG063142) 

• On Mac, you cannot install to the root drive. (#BG044824) 

• When installing a 32-bit application on Vista 64-bit, an incorrect default installation 
location appears.  The application will be installed in the correct location: c:\program 
files(x86). (#BG064131) 

• The “Total Size” displayed in the installer Options screen includes space required for 
components required for the installation but not shown in the component list, so the 
number may not equal the listed components size. (#BG059229) 

• The installation may take 20 minutes to over 1 hour depending on the product and 
the number of components chosen to be installed.  (#BG050030) 

• Creative Suite 4 cannot be installed to an encrypted folder. (#BG065106) 

• Although you can choose to install an edition of Creative Suite 4 on a secondary 
partition, the installer still requires up to 6GB of free space available on the primary 
partition to complete the installation.  The amount of free space needed depends on 
the components chosen to be installed. 

• Protected Content for Adobe Premiere Pro, After Effects, Encore, Soundbooth and 
OnLocation will be installed, even if those applications have been not been selected 
for installation.  It will appear as though the applications have been installed: 
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application folders will appear in the Start menu on Windows or in the Applications 
folder on Mac.  However, upon attempting to launch one of these applications, an 
error message will appear saying "You can't open the application because it is not 
support on this architecture." (#BG063851) 

• For more detailed information about installing, go to 
http://www.adobe.com/support/loganalyzer/. 

Note: In order to install additional components or reinstall your software after your original 
installation, you will need access to the original installer (CD, DVD or the download from the 
web).  Repair is not an available option. 

Uninstall your software 

1. Before you uninstall, close all applications currently running on your system—including 
other Adobe applications, Microsoft Office applications, and browser windows.  

2. Do one of the following:  
o In Windows XP, open the Windows Control Panel and double-click Add or 

Remove Programs. Select the product that you want to uninstall, click 
Change/Remove, and then follow the on-screen instructions. 

o In Windows Vista, open the Windows Control Panel and double-click Programs 
and Features. Select the product that you want to uninstall, click 
Uninstall/Change, and then follow the on-screen instructions.  

o IMPORTANT: Mac OS has new uninstall functionality. DO NOT drag applications 
to the trash to uninstall them. To safely uninstall on Mac OS X, double-click the 
uninstall alias located in Applications/Utilities/Adobe Installers or in the 
Application folder. Authenticate as an administrator, then follow the on-screen 
instructions. 

Known issues 

• The uninstall process will remove any custom folders added to the installed 
application folders. (#BG69109) 

• Please note some files will remain on your system following an uninstall of Creative 
Suite 4 applications. 

 

Purchase from a trial 

If you have installed a trial version of Creative Suite 4 Production Premium, you can enter a serial 
number to convert it from a trial.  It is not necessary to uninstall. 

You can convert a trial by entering the serial number you received when purchasing Production 
Premium.  Launch any of the Production Premium applications and enter the serial number in the 
serialization screen. 

Other applications installed as part of Production Premium will recognize the new serial number 
the next time the applications are launched.  Only applications running as a trial will recognize the 
new serial number.  If any of the applications have already been serialized with a different serial 
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number, it will continue to use that serial number until you remove the older serial number using 
the Help > Deactivate > Erase my serial number.  Then on the next launch of the application, it 
will recognize the new serial number. 

The serial number you purchased is for the use of the software in a specific language, and will 
only be accepted by a product installed in that language. 

Volume licensing customers cannot purchase a volume license from a trial directly, however a 
volume licensing serial number can be entered in the trial software without having to uninstall and 
reinstall.  Please contact your reseller or authorized Adobe licensing center to place an order for a 
volume license.  To find a reseller in your area, go to 
http://partners.adobe.com/resellerfinder/na/reseller.jsp. 

Electronic licensing 
 
This product is offered subject to your acceptance of the license agreement included with the 
media and to limited warranty terms. See the Adobe Software License Agreement for details. The 
software may automatically attempt to activate over the Internet. No personally identifiable 
information will be transmitted, except to the extent that IP addresses may be considered 
personally identifiable in some jurisdictions. To learn more, visit the Adobe web site at 
http://www.adobe.com/go/activation. 
 
 
Note: If you want to install a product on a different computer, you should first deactivate the serial 
number on your computer. To deactivate, choose Help > Deactivate. Deactivation of a serial 
number will apply to all components activated with that serial number.  If you launch a product on 
the same computer after deactivating, it will activate again. 
 
Registration information 

When you install your software, be sure to register to get up-to-date product information, training, 
newsletters, and invitations to Adobe events and seminars.  If you don't register when you install 
you can always register later from within any CS4 component by selecting Help > Registration. 

Font installation 

All font related documentation is online.  Visit 
http://www.adobe.com/type/browser/landing/creativesuite/creativesuite4.html to find our 
OpenType User Guide, OpenType ReadMe, links to font specific readmes, listings of fonts 
installed by the different CS4 products, and listings of fonts included on DVD for each of the CS4 
products. 

The Creative Suite 4 installer installs fonts into a default system font directory. Many of these 
fonts are newer versions of fonts installed by Creative Suite 3. If the installer finds older versions 
of these fonts in the default system font directory, it will  de-install the older versions, and save 
them to a new directory.  The default system font directory is: 

    Apple Macintosh:  <System Disk>/Library/Fonts 

    Windows: <System Disk>:\Windows\Fonts 

The older fonts will be saved in the new directory: 
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    Apple Macintosh:  <System Disk>/Library/Application Support/Adobe/SavedFonts/current 

    Windows: <System Disk>:\Program Files\Common Files\Adobe\SavedFonts\current 

This new directory will also contain a file named "Read Me.html" which lists the saved fonts, and 
the version numbers of the new and of the old font files. 

You can re-install the older fonts by deleting the new font files from the default system font 
directory , and moving the old files back into that directory. 

There are additional fonts on the installation disk. For information on installing these fonts, see 
http://www.adobe.com/go/learn_fontinstall_en. 

Known issues 

Please refer to Adobe Support for late-breaking information and known issues for all Creative 
Suite 4 applications. 

GB18030 support for Windows XP 

• In order to support the display of all characters of the Chinese standard GB18030 on 
Windows XP systems, Adobe recommends the installation of the Microsoft GB18030 Support 
Package. This support package will update an XP system with, among other things, fonts and 
input-method-editors (IMEs) to correctly support GB18030. The support package is available 
as a download from the Microsoft website. (#BG061690) 

Deactivation 

• On Windows, deactivation may fail with the error "Internet not found" even if there is an 
Internet connection.  Go to Internet Options -> Advanced and uncheck "Check for server 
certificate revocation" and re-try deactivation. (#BG056982) 

Search For Help 

• Search for Help will launch Internet Explorer even though Firefox has been set as the default 
browser.  (#1677521) 

Soundbooth CS4 

• Double-clicking to open a saved ASND file in Soundbooth that contains a linked asset will 
result in the composition/sequence showing as offline.  To avoid this, open the ASND file 
using File > Open instead of double-clicking. 

OnLocation CS4 

• On Windows, if OnLocation has been installed as a trial, clicking on the "Quit" button in the 
serialization screen at launch may cause OnLocation to quit unexpectedly.  To avoid this, 
close the serialization screen by choosing File > Close from the File menu.  (#BG070812) 
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Customer care 

Customer Service 
Adobe Customer Service provides assistance with product information, sales, registration, and 
other non-technical issues. To find out how to contact Adobe Customer Service, please visit 
Adobe.com for your region or country and click on Contact. 

Support Plan Options and Technical Resources  
If you require technical assistance for your product, including information on complimentary and 
fee-based support plans and troubleshooting resources, more information is available at 
http://www.adobe.com/go/support/.  Outside of North America, go to 
http://www.adobe.com/go/intlsupport/ and click on Change beside the country name in order to 
select your own area. 
 
Free troubleshooting resources include Adobe’s support knowledgebase, Adobe user-to-user 
forums and more.  We are continually making additional tools and information available online in 
order to provide you with flexible options for resolving issues as fast as possible. 

If you are having any issues with installing or uninstalling any of your Creative Suite 4 
applications, please try rebooting your system prior to contacting Support.  For additional CS4 
installation help, go to www.adobe.com/go/cs4install/. 

 
Other resources 

Documentation 
Order printed documentation at www.adobe.com/go/buy_books. 

Online Resources 
 
For complete Help plus community-based instruction, inspiration, and support, go to 
www.adobe.com/go/creativesuite4_community_help. 
 
You can also go to Bridge Home: 
From any Creative Suite 4 application, choose File > Browse… > Bridge. Once Bridge opens, 
click on the Bridge Home button in the Favorites panel. 
 
 
Adobe website 
Adobe TV 
Adobe Design Center  
Developer Center  
User Forums 
Training 
Adobe Certification Program 
Adobe Partner Programs 
Find an Adobe Authorized Training Center  
Find an Adobe Authorized Print Service Provider 
 
 
Individual product information 
  
Adobe Flash CS4 Professional  Adobe Bridge CS4 
  Read Me   New Features  
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Adobe® 

 

Creative Suite 4 Production Premium — Lisez-moi 
 
Bienvenue dans Adobe® Creative Suite® 4 Production Premium. Ce document vous livre des informations 
de dernière minute sur le produit et ses mises à jour, ainsi que des conseils de dépannage ne figurant pas 
dans la documentation Creative Suite 4 Production Premium. 
 

Applications Creative Suite 4 Production Premium 
Configuration minimale requise 
Installation du logiciel 
Désinstallation du logiciel 
Achat suite à un essai 
Licence électronique 
Informations d’enregistrement 
Installation des polices 
Problèmes connus 
Assistance clientèle 
Autres ressources 
Informations par produit 
 

Applications Creative Suite 4 Production Premium 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4 (avec accès direct à Version Cue® et Adobe® Device Central) 
• Adobe Dynamic Link 
• Adobe Media Player 

Configuration minimale requise 
 
Windows® 

• Processeur cadencé à 2 GHz ou plus rapide pour le DV et à 3,4 GHz pour le HDV ou processeur 
double cœur cadencé à 2,8 GHz pour le HD* 

• Microsoft® Windows® XP avec Service Pack 2 (Service Pack 3 conseillé) ou Windows Vista® 
Édition Familiale Premium, Édition Professionnel, Intégrale ou Entreprise avec Service Pack 1 
(certifié pour Windows XP 32 bits et Windows Vista† 32 bits) 

• 2 Go de RAM (supplément de RAM recommandé pour l’exécution de plusieurs composants) 
• 16,3 Go d’espace disque disponible pour l’installation ; espace supplémentaire requis pendant 

l’installation (installation impossible sur les périphériques de stockage à mémoire flash) 
• Résolution d’affichage de 1 280 x 900 avec carte graphique compatible OpenGL 2.0‡ 



 
 

• Prise en charge graphique de Shader Model 3.0 
• Lecteur de disque dur à 7 200 tr/mn réservé au montage DV et HDV ; stockage (RAID 0) sur 

matrice de disque pistée pour le HD ; sous-système de disque SCSI de préférence 
• Pour les flux au format SD/HD, carte certifiée Adobe pour l’acquisition et l’exportation sur bande‡ 
• Port IEEE 1394 compatible OHCI pour l’acquisition aux formats DV et HDV, l’exportation sur 

bande et le transfert sur matériel DV 
• Lecteur de DVD-ROM (graveur DVD+-R nécessaire pour la création de DVD) 
• Graveur Blu-ray nécessaire pour la création de disques Blu-ray 
• Carte son compatible Microsoft Windows Driver Model ou ASIO 
• Logiciel QuickTime 7.4.5 nécessaire pour l’exploitation des fonctions QuickTime  
• Connexion Internet haut débit requise pour les services en ligne 

 
* Processeur SSE2 nécessaire pour les systèmes AMD 
 
† Adobe Photoshop Extended prend en charge en mode natif les éditions 64 bits de Windows. Adobe 
Premiere Pro, After Effects, Soundbooth, Encore et Adobe OnLocation sont certifiés sur Windows Vista 
64 bits. Rendez-vous sur www.apple.fr pour en savoir plus sur la compatibilité de QuickTime avec les 
éditions 64 bits de Windows. 
 
Macintosh  

• Processeur Intel® multicœur 
• Mac OS X v10.4.11–10.5.4 
• Java™ Runtime Environment 1.5 nécessaire pour Adobe Version Cue Server 
• 2 Go de RAM (supplément de RAM recommandé pour l’exécution de plusieurs composants) 
• 20,6 Go d’espace disque disponible pour l’installation ; espace supplémentaire requis pendant 

l’installation (installation impossible sur un volume qui utilise un système de fichiers sensible à la 
casse ou sur des périphériques de stockage basés sur flash) 

• Résolution d’affichage de 1 280 x 900 avec carte graphique compatible OpenGL 2.0‡ 
• Prise en charge de Shader Model 3.0 et d’OpenGL 2.0 nécessaire pour l’exécution de certaines 

fonctionnalités exploitant l’accélération GPU 
• Lecteur de disque dur à 7 200 tr/mn réservé au montage DV et HDV ; stockage (RAID 0) sur 

matrice de disque pistée pour le HD ; sous-système de disque SCSI de préférence 
• Lecteur de DVD-ROM (SuperDrive nécessaire pour la gravure de DVD) 
• Graveur Blu-ray nécessaire pour la création de disques Blu-ray 
• Carte son compatible Core Audio 
• Logiciel QuickTime 7.4.5 nécessaire pour l’exploitation des fonctions QuickTime  
• Connexion Internet haut débit requise pour les services en ligne 

 
‡ Pour connaître la dernière configuration minimale requise en date et obtenir plus d’informations sur la 
compatibilité du matériel vidéo, rendez-vous sur 
www.adobe.com/fr/products/creativesuite/production/systemreqs. 
 
Ce produit peut vous permettre d’accéder à certaines fonctions hébergées en ligne (« services en ligne »), 
si vous disposez d’une connexion Internet haut débit. Les services en ligne et certaines de leurs fonctions 
peuvent ne pas être disponibles dans tous les pays, toutes les langues et/ou devises et ne plus être 
assurés en tout en ou en partie sans avis préalable. L’utilisation des services en ligne est régie par des 
conditions d’utilisation distinctes et par la politique de confidentialité des données en ligne d’Adobe, et 
l’accès à ces services peut nécessiter l’enregistrement de l’utilisateur. Certains services en ligne, 
notamment les services initialement offerts gratuitement, peuvent faire l’objet de frais supplémentaires. 
Pour plus de détails et pour lire les conditions d’utilisation et la politique de confidentialité des données en 
ligne, rendez-vous sur le site www.adobe.com/fr/. 
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Installation du logiciel 

1. Avant d’installer le logiciel, fermez toutes les applications en cours d’exécution sur le système, 
y compris les autres applications Adobe, les applications Microsoft Office et les fenêtres de 
navigateur. Il est également recommandé de désactiver temporairement la protection antivirus 
pendant l’installation. 

2. Vous devez disposer des droits d’administrateur ou être habilité à agir en qualité d’administrateur. 
3. Procédez de l’une des façons suivantes :  

Windows :  
o Insérez le DVD du produit dans le lecteur approprié, puis suivez les instructions qui 

s’affichent à l’écran. Si le lancement du programme d’installation n’est pas automatique, 
accédez au dossier Adobe CS4 situé à la racine de votre disque, puis cliquez deux fois 
sur Setup.exe pour lancer l’installation.  

o Si vous avez téléchargé le logiciel depuis le Web, ouvrez le dossier correspondant, 
naviguez jusqu’au dossier Adobe CS4, cliquez deux fois sur Setup.exe, puis suivez les 
instructions qui s’affichent à l’écran. 

Macintosh :  
o Insérez le DVD du produit dans le lecteur approprié, puis suivez les instructions qui 

s’affichent à l’écran. Si le lancement du programme d’installation n’est pas automatique, 
accédez au dossier de l’application situé à la racine de votre disque, puis cliquez deux 
fois sur Setup (Mac OS®) pour lancer l’installation.  

o Si vous avez téléchargé le logiciel depuis le Web, ouvrez le dossier correspondant, 
naviguez jusqu’au dossier de l’application, cliquez deux fois sur Setup, puis suivez les 
instructions qui s’affichent à l’écran. 

4. Le programme d’installation recherche, le cas échéant, le produit auquel s’applique la mise à 
niveau sur votre système. S’il est introuvable, vous devrez saisir le numéro de série du produit 
pour lequel vous installez la mise à niveau. Vous pouvez également installer la version 
d’évaluation du logiciel puis saisir vos nouveau et ancien numéros de série dans l’écran 
correspondant qui s’affiche pendant le lancement. 

5. Pour obtenir de l’aide supplémentaire sur l’installation de CS4, rendez-vous sur 
http://www.adobe.com/go/cs4install_fr/. 

Problèmes connus 

• Sous Mac, une fois l’installation terminée, les performances du système peuvent être 
ralenties. Redémarrez le système après l’installation pour résoudre le problème. 
(#BG063142) 

• Sous Mac, vous ne pouvez pas installer sur le lecteur racine. (#BG044824) 

• Un emplacement d’installation par défaut incorrect apparaît au cours de l’installation d’une 
application 32 bits sur Windows Vista 64 bits. L’application sera installée à l’emplacement 
correct suivant : c:\program files(x86). (#BG064131) 

• La taille totale affichée dans l’écran Options du programme d’installation inclut l’espace 
nécessaire pour les composants requis pour l’installation mais qui ne figurent pas dans la liste 
des composants ; il est donc possible que le total indiqué ne corresponde pas à la taille des 
composants répertoriés. (#BG059229) 

• L’installation peut prendre de 20 minutes à plus d’une heure selon le produit et le nombre de 
composants à installer. (#BG050030) 
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• Il est impossible d’installer Creative Suite 4 dans un dossier chiffré. (#BG065106) 

• Bien que vous puissiez choisir d’installer une édition de Creative Suite 4 sur une partition 
secondaire, le programme d’installation nécessite toutefois 6 Go d’espace disque disponible 
sur la partition principale pour l’installation. Le volume d’espace libre nécessaire varie selon 
les composants que vous choisissez d’installer. 

• Les contenus protégés pour Adobe Premiere Pro, After Effects, Encore, Soundbooth 
et OnLocation seront installés même si l’installation de ces applications n’est pas prévue. Ces 
applications sembleront installées : les dossiers d’application correspondants apparaîtront 
dans le menu Démarrer sous Windows ou dans le dossier Applications sous Mac OS. 
Cependant, à chaque tentative de lancement de l’une de ces applications, un message 
d’erreur signalera qu’il est impossible d’ouvrir l’application car elle n’est pas prise en charge 
sur cette architecture. (#BG063851) 

• Pour obtenir des informations plus détaillées, rendez-vous sur 
http://www.adobe.com/go/support_loganalyzer_fr/. 

Remarque : Vous aurez besoin du programme d’installation d’origine (CD, DVD ou fichier téléchargé 
depuis le Web) de votre logiciel pour le réinstaller ou en installer d’autres composants après la première 
installation. L’option de réparation n’est pas disponible. 

Désinstallation du logiciel 

1. Avant de procéder à la désinstallation du produit, fermez toutes les applications en cours 
d’exécution sur votre système, y compris les autres logiciels Adobe, les applications 
Microsoft Office et les navigateurs.  

2. Procédez de l’une des façons suivantes :  
o Sous Windows XP, ouvrez le panneau de configuration Windows, puis cliquez deux fois 

sur Ajout/Suppression de programmes. Sélectionnez le produit à désinstaller, cliquez sur 
Modifier/Supprimer, puis suivez les instructions qui s’affichent à l’écran. 

o Sous Windows Vista, ouvrez le panneau de configuration Windows, puis cliquez deux fois 
sur Programmes et fonctionnalités. Sélectionnez le produit à désinstaller, cliquez 
sur Désinstaller/Supprimer, puis suivez les instructions qui s’affichent à l’écran.  

o IMPORTANT : Mac OS dispose d’une nouvelle fonctionnalité de désinstallation. Ne faites 
pas glisser les applications vers la corbeille pour les désinstaller. Pour désinstaller en 
toute sécurité une application sous Mac OS X, cliquez deux fois sur l’alias de 
désinstallation correspondant dans Applications/Utilities/Adobe Installers ou dans le 
dossier Application. Identifiez-vous en tant qu’administrateur, puis suivez les instructions 
qui s’affichent à l’écran. 

Problèmes connus 

• La désinstallation supprime tous les dossiers personnalisés ajoutés aux dossiers des 
applications installées. (#BG69109) 

• Certains fichiers demeureront sur le système après la désinstallation d’applications 
Creative Suite 4. 
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Achat suite à un essai 

Si vous avez installé une version d’évaluation de Creative Suite 4 Production Premium, vous pouvez la 
convertir sans la désinstaller. 

Il vous suffit pour cela d’indiquer le numéro de série qui vous a été fourni à l’achat de l’édition 
Production Premium. Lancez une application de la suite Production Premium, puis saisissez le numéro de 
série dans l’écran correspondant. 

Le nouveau numéro de série sera reconnu par les autres applications installées avec l’édition 
Production Premium lors de leur prochain lancement. Seules les applications exécutées en version 
d’essai reconnaîtront le nouveau numéro de série. Si l’une des applications a été activée avec un numéro 
de série différent, il reste valide tant que vous n’effacez pas l’ancien numéro de série à l’aide de la 
commande Aide > Désactiver > Effacer mon numéro de série. Le nouveau numéro de série sera ensuite 
reconnu au lancement suivant de l’application. 

Le numéro de série du logiciel acheté est réservé à son utilisation dans une langue donnée et sera 
accepté pour un produit installé dans cette langue uniquement. 

Il n’existe aucun programme direct d’achat de licences en volume à partir d’une version d’évaluation. Il est 
toutefois possible de saisir le numéro de série d’une licence en volume dans l’écran correspondant du 
logiciel d’évaluation sans avoir à le désinstaller et à le réinstaller. Pour passer une commande de licences 
en volume, contactez votre revendeur ou votre centre d’achat de licences agréé Adobe. Pour trouver un 
revendeur près de chez vous, rendez-vous sur http://partners.adobe.com/resellerfinder/na/reseller.jsp. 

Licence électronique 
 
Ce produit, dont l’utilisation est subordonnée à l’acceptation du contrat de licence fourni sur le support, fait 
l’objet d’une garantie limitée. Pour plus de détails, consultez le contrat de licence du logiciel Adobe. Une 
tentative d’activation automatique du logiciel sur Internet est possible. Aucune information personnelle ne 
sera transmise, en dehors des adresses IP qui, dans certaines juridictions, peuvent être considérées 
comme telles. Pour en savoir plus, consultez le site Web d’Adobe à l’adresse 
http://www.adobe.com/go/activation_fr. 
 
 
Remarque : Si vous souhaitez installer le produit sur un autre ordinateur, vous devez préalablement le 
désactiver sur le premier ordinateur. Pour désactiver le logiciel, choisissez Aide > Désactiver. La 
désactivation d’un numéro de série s’applique à tous les composants activés avec ce numéro. Si vous 
lancez un produit sur le même ordinateur après l’avoir désactivé, il est réactivé. 
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Informations d’enregistrement 

Lorsque vous installez le logiciel, veillez à procéder à son enregistrement pour bénéficier d’informations 
actualisées, de formations, de bulletins d’information et d’invitations aux événements et 
séminaires Adobe. A défaut d’enregistrer votre logiciel à la fin de l’installation, vous pouvez le faire 
ultérieurement à partir de tous les composants CS4 en choisissant Aide > Enregistrement. 

Installation des polices 

Toute documentation liée aux polices est disponible en ligne. Rendez-vous à la page 
http://www.adobe.com/go/cs4type_fr pour accéder au guide de l’utilisateur OpenType (OpenType User 
Guide), au fichier Lisez-moi OpenType (OpenType ReadMe), à des liens pointant vers des fichiers Lisez-
moi sur les polices, aux listes de polices installées avec les divers produits CS4 et aux listes de polices 
incluses sur le DVD pour chaque produit CS4. 

Le programme d’installation Creative Suite 4 installe les polices dans un répertoire de polices système 
par défaut. Il s’agit principalement des versions plus récentes de polices installées avec Creative Suite 3. 
Si le programme d’installation détecte d’anciennes versions de ces polices dans le répertoire de polices 
par défaut, il désinstalle ces anciennes versions et les enregistre dans un nouveau répertoire. Vous 
trouverez ci-dessous le répertoire de polices par défaut : 

    Apple Macintosh : <Disque système>/Library/Fonts 

    Windows : <Disque système>:\Windows\Fonts 

Les anciennes polices sont enregistrées dans un nouveau répertoire : 

    Apple Macintosh : <Disque système>/Library/Application Support/Adobe/SavedFonts/current 

    Windows : <Disque système>:\Program Files\Fichiers communs\Adobe\SavedFonts\current 

Ce nouveau répertoire contient également un fichier « Lisez-moi.html » qui répertorie les polices 
enregistrées et les numéros de version du nouveau et de l’ancien fichier de polices. 

Vous pouvez réinstaller les anciennes polices en supprimant les nouveaux fichiers de polices du 
répertoire de polices par défaut et en déplaçant les anciens fichiers vers ce répertoire. 

Vous trouverez d’autres polices sur le disque d’installation. Pour plus de détails sur l’installation de ces 
polices, rendez-vous sur http://www.adobe.com/go/learn_fontinstall_fr. 
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Problèmes connus 

Consultez le site Web de support Adobe pour obtenir des informations de dernière minute et des 
renseignements sur des problèmes connus pour toutes les applications Creative Suite 4. 

Prise en charge de la norme GB18030 pour Windows XP 

• Pour garantir l’affichage de tous les caractères de la norme chinoise GB18030 sur les systèmes 
Windows XP, Adobe recommande l’installation du package de prise en charge Microsoft GB18030. 
Ce package de prise en charge a pour fonction de mettre à jour un système XP, notamment ses 
polices et ses éditeurs de méthodes d’entrée (IME, input-method-editor) de sorte qu’il exploite 
correctement le jeu de caractères GB18030. Vous pouvez télécharger ce package de prise en charge 
depuis le site Web de Microsoft. (#BG061690) 

Désactivation 

• Sous Windows, la désactivation peut échouer et générer une erreur du type « Internet non détecté » 
même si une connexion Internet est établie. Accédez à l’écran Options Internet -> Avancés pour 
désélectionner l’option « Vérifier la révocation du certificat de serveur », puis faites une nouvelle 
tentative de désactivation. (#BG056982) 

Search For Help 

• La fonction Search for Help lance Internet Explorer même si Firefox est configuré comme 
navigateur Web par défaut. (#1677521) 

Soundbooth CS4 

• Si vous cliquez deux fois sur un fichier ASND enregistré pour l’ouvrir dans Soundbooth alors qu’il 
contient un actif, la composition/séquence s’affiche hors ligne. Pour contourner ce problème, 
choisissez Fichier > Ouvrir pour ouvrir le fichier ASND. 

OnLocation CS4 

• Sous Windows, si OnLocation est installé comme version d’évaluation, l’application peut se fermer 
inopinément à la suite de la sélection du bouton « Quitter » dans l’écran de saisie du numéro de série 
pendant son lancement. Pour contourner ce problème, choisissez Fichier > Fermer pour refermer 
l’écran de saisie du numéro de série. (#BG070812) 
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Assistance clientèle 

Le service clientèle d’Adobe propose une assistance sur les produits, la vente, l’enregistrement et d’autres 
sujets non techniques. Pour contacter le service clientèle d’Adobe, consultez la page du site Adobe.com 
correspondant à votre région ou pays et cliquez sur Contact. 

Options du programme de support et ressources techniques  
Si vous avez besoin d’une assistance technique pour votre produit, notamment des informations sur 
l’assistance gratuite et prépayée, ainsi que les ressources de dépannage, vous trouverez des informations 
sur http://www.adobe.com/go/support_fr/. Si vous vous trouvez en dehors de l’Amérique du Nord, rendez-
vous sur http://www.adobe.com/support/intlsupport_fr/, puis cliquez sur Change en regard du nom de 
pays pour sélectionner votre zone géographique. 
 
Vous trouverez des ressources gratuites de dépannage dans notre base de connaissances, sur les 
forums d’utilisateurs Adobe, etc. Nous vous proposons en permanence des outils et des informations 
supplémentaires accessibles en ligne afin que vous disposiez des moyens adaptés pour résoudre vos 
problèmes dans les meilleurs délais. 

Si vous rencontrez des problèmes pendant l’installation ou la désinstallation d’une application Creative 
Suite 4, essayez de redémarrer votre système avant de contacter le service d’assistance. Pour obtenir de 
l’aide supplémentaire sur l’installation de CS4, rendez-vous sur www.adobe.com/go/cs4install_fr. 

 
Autres ressources 

Documentation 

Commandez la documentation imprimée sur www.adobe.com/go/buy_books_fr. 

Ressources en ligne 
 
Pour obtenir une aide complète ainsi que des instructions, des références et tout autre type d’assistance 
concernant les communautés, rendez-vous sur 
http://www.adobe.com/go/creativesuite4_community_help_fr 
 
Vous pouvez également vous rendre sur Bridge Home : 
Depuis une application Creative Suite 4, choisissez Fichier > Parcourir… > Bridge. Une fois Bridge ouvert, 
cliquez sur le bouton Bridge Home dans le panneau Favoris. 
 
 
Site Web d’Adobe 
Adobe TV 
Pôle de création Adobe  
Pôle de développement  
Forums utilisateurs 
Formation 
Programme de certification Adobe 
Programmes de partenariat Adobe 
Trouver un centre de formation agréé Adobe 
Trouver un flasheur/imprimeur agréé Adobe 
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Adobe®
 

 

Creative Suite 4 Production Premium – Bitte lesen 
 
Willkommen bei Adobe® Creative Suite® 4 Production Premium. Dieses Dokument enthält 
aktuelle Produktinformationen, neueste Informationen sowie Tipps zur Problembehebung, 
die nicht in der Dokumentation zu Creative Suite 4 Production Premium enthalten sind. 
 

Anwendungen in Creative Suite 4 Production Premium 
Mindestsystemanforderungen 
Installation der Software 
Deinstallation der Software 
Erwerb über eine Testversion 
Elektronische Lizenzierung 
Registrierungsinformationen 
Installation von Schriftarten 
Bekannte Probleme 
Kundenbetreuung 
Weitere Informationsquellen 
Informationen zu den einzelnen Produkten 
 

Anwendungen in Creative Suite 4 Production Premium 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4 (ermöglicht den direkten Zugriff auf Version Cue® und Adobe® Device 

Central) 
• Adobe Dynamic Link 
• Adobe Media Player 



 
 

Mindestsystemanforderungen 
 
Windows® 

• Prozessor mit mindestens 2 GHz für DV; 3,4 GHz für HDV; 2,8 GHz-Dual-Core für HD* 
• Microsoft® Windows® XP mit Service Pack 2 (Service Pack 3 empfohlen) oder Windows 

Vista® Home Premium, Business, Ultimate oder Enterprise mit Service Pack 1 (zertifiziert 
für 32-Bit-Windows XP und Windows Vista†) 

• 2 GB RAM (beim Ausführen von mehreren Komponenten wird weiterer Arbeitsspeicher 
empfohlen) 

• 16,3 GB freier Festplattenspeicherplatz für die Installation; während der Installation ist 
zusätzlicher Speicherplatz erforderlich (eine Installation auf USB-Wechseldatenträgern ist 
nicht möglich) 

• Bildschirmauflösung von 1280 x 900 mit OpenGL 2.0-kompatibler Grafikkarte‡ 
• Grafikunterstützung für Shader Model 3.0 
• Dedizierte Festplatte mit 7200 U/min für DV- und HDV-Bearbeitung; Disk-Array-Speicher 

(Striped, RAID 0) für HD; SCSI-Festplattensubsystem bevorzugtAdobe-zertifizierte Karte 
für die Erfassung und den Export auf Band für SD/HD-Workflows‡ 

• OHCI-kompatibler IEEE 1394-Anschluss für DV- und HDV-Erfassung, Export auf Band 
und Übertragung auf DV-Gerät 

• DVD-ROM-Laufwerk (DVD+-R-Brenner für DVD-Erstellung erforderlich) 
• Blu-ray-Brenner für Blu-ray-Disc-Erstellung erforderlich 
• Microsoft Windows Driver Model- oder ASIO-kompatible Soundkarte 
• QuickTime 7.4.5 für Nutzung der QuickTime-Funktionen erforderlich  
• DSL-Anschluss für Onlinedienste erforderlich 

 
*Ein SSE2-fähiger Prozessor ist für AMD-Systeme erforderlich 
 
† Adobe Photoshop Extended unterstützt 64-Bit-Editionen von Windows. Adobe Premiere Pro, 
After Effects, Soundbooth, Encore und Adobe OnLocation sind für 64-Bit-Windows Vista 
zertifiziert. Auf der Seite http://www.apple.com/de finden Sie Informationen zur QuickTime-
Kompatibilität mit 64-Bit-Editionen von Windows. 
 
Mac OS  

• Intel®-Multicore-Prozessor 
• Mac OS X Version 10.4.11-10.5.4 
• Java™ Runtime Environment 1.5 für Adobe Version Cue Server erforderlich 
• 2 GB RAM (beim Ausführen von mehreren Komponenten wird weiterer Arbeitsspeicher 

empfohlen) 
• 20,6 GB freier Festplattenspeicherplatz für die Installation; während der Installation ist 

zusätzlicher Speicherplatz erforderlich (eine Installation auf einem Laufwerk-Dateisystem, 
das Groß- und Kleinschreibung berücksichtigt, oder auf USB-Wechseldatenträgern ist 
nicht möglich). 

• Bildschirmauflösung von 1280 x 900 mit OpenGL 2.0-kompatibler Grafikkarte‡ 
• Für einige GPU-beschleunigte Funktionen wird Grafikunterstützung für Shader Model 3.0 

und OpenGL 2.0 benötigt. 
• Dedizierte Festplatte mit 7200 U/min für DV- und HDV-Bearbeitung; Disk-Array-Speicher 

(Striped, RAID 0) für HD; SCSI-Festplattensubsystem bevorzugt 
• DVD-ROM-Laufwerk (SuperDrive für DVD-Erstellung erforderlich) 
• Blu-ray-Brenner für Blu-ray-Disc-Erstellung erforderlich 
• Core Audio-kompatible Soundkarte 
• QuickTime 7.4.5 für Nutzung der QuickTime-Funktionen erforderlich  
• DSL-Anschluss für Onlinedienste erforderlich 
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‡ Die jeweils aktuellsten Systemanforderungen und weitere Informationen zur Videohardware-
Kompatibilität finden Sie auf der http://www.adobe.com/go/production_systemreqs_de. 
 
Mit diesem Produkt können Sie möglicherweise auf bestimmte Onlinefunktionen („Onlinedienste“) 
zugreifen, sofern Sie mindestens über eine Hochgeschwindigkeits-Internetverbindung verfügen. 
Die Onlinedienste und einige der zugehörigen Funktionen sind möglicherweise nicht in allen 
Ländern, Sprachen und/oder Währungen verfügbar und werden u. U. im Ganzen oder zum Teil 
ohne vorherige Ankündigung nicht mehr angeboten. Die Nutzung der Onlinedienste unterliegt 
gesonderten Nutzungsbedingungen sowie der Online-Datenschutzrichtlinie von Adobe. Für den 
Zugriff auf diese Dienste ist möglicherweise eine Benutzerregistrierung erforderlich. Einige 
Onlinedienste können gebührenpflichtig sein. Dies gilt auch für Dienste, die zunächst kostenlos 
angeboten wurden. Weitere Informationen sowie die Nutzungsbedingen und die Online-
Datenschutzrichtlinie von Adobe finden Sie unter http://www.adobe.com/de. 
 
Installation der Software 

1. Schließen Sie vor der Installation alle derzeit auf dem System ausgeführten 
Anwendungen, einschließlich anderer Adobe-Anwendungen, Microsoft Office-
Anwendungen und Browserfenstern. Ebenso wird empfohlen, während des 
Installationsvorgangs alle Virenschutzprogramme zu deaktivieren. 

2. Sie müssen über administrative Rechte verfügen oder sich als Administrator anmelden 
können. 

3. Führen Sie einen der folgenden Schritte durch:  

Windows:  
o Legen Sie die DVD in das Laufwerk ein und befolgen Sie die Anweisungen auf 

dem Bildschirm. Wird das Installationsprogramm nicht automatisch gestartet, 
doppelklicken Sie im Ordner „Adobe CS4“ auf der Stammebene des 
Datenträgers auf „Setup.exe“, um den Installationsvorgang zu starten.  

o Wenn Sie die Software aus dem Internet heruntergeladen haben, öffnen Sie den 
Ordner, navigieren Sie zum Ordner „Adobe CS4“ und doppelklicken Sie auf 
„Setup.exe“. Befolgen Sie dann die Anweisungen auf dem Bildschirm. 

Mac:  
o Legen Sie die DVD in das Laufwerk ein und befolgen Sie die Anweisungen auf 

dem Bildschirm. Wird das Installationsprogramm nicht automatisch gestartet, 
doppelklicken Sie im Anwendungsordner auf der Stammebene des Datenträgers 
auf „Setup Mac OS®“, um den Installationsvorgang zu starten.  

o Wenn Sie die Software aus dem Internet heruntergeladen haben, öffnen Sie den 
Ordner, navigieren Sie zum Anwendungsordner und doppelklicken Sie auf 
„Setup“. Befolgen Sie dann die Anweisungen auf dem Bildschirm. 

4. Wenn Sie eine Aktualisierung installieren, überprüft das Installationsprogramm das 
System auf gültige aktualisierbare Produkte. Wird das Produkt nicht gefunden, werden 
Sie dazu aufgefordert, die Seriennummer des Produkts einzugeben, das aktualisiert 
werden soll. Sie können die Software auch als Testversion installieren und zu einem 
späteren Zeitpunkt beim Starten der Anwendung Ihre neue oder bisherige Seriennummer 
in das dafür vorgesehene Fenster eingeben. 

5. Weitere Informationen zur Installation von CS4 finden Sie auf der Seite 
www.adobe.com/go/cs4install_de/. 
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Bekannte Probleme 

• Auf Mac-Systemen kann die Systemleistung nach der Installation verlangsamt 
erscheinen. Starten Sie das System nach der Installation neu, um dieses Problem zu 
beheben. (Nr. BG063142) 

• Auf Mac-Systemen können Sie nicht auf dem Stammlaufwerk installieren. 
(Nr. BG044824) 

• Bei der Installation einer 32-Bit-Anwendung unter der 64-Bit-Version von Vista wird 
ein falscher Standardinstallationsordner angezeigt. Die Anwendung wird jedoch im 
richtigen Ordner installiert: C:\Programme(x86). (Nr. BG064131) 

• Der Wert „Gesamtgröße“, der im Optionenbildschirm des Installationsprogramms 
angezeigt wird, beinhaltet Speicherplatz für Komponenten, die für die Installation 
benötigt werden, jedoch nicht in der Komponentenliste aufgeführt sind. Der 
angezeigte Wert muss also nicht mit der Größe der aufgeführten Komponenten 
übereinstimmen. (Nr. BG059229) 

• Je nach Produkt und ausgewählter Anzahl der Komponenten kann die Installation 
zwischen 20 Minuten und mehr als einer Stunde dauern. (Nr. BG050030) 

• Creative Suite 4 kann nicht in einem verschlüsselten Ordner installiert werden. 
(Nr. BG065106) 

• Sie können eine Edition der Creative Suite 4 auf einer sekundären Partition 
installieren; das Installationsprogramm benötigt dennoch bis zu 6 GB freien 
Speicherplatz auf der primären Partition, um die Installation abzuschließen. 
Die benötigte Menge an freiem Speicherplatz hängt davon, welche Komponenten 
für die Installation ausgewählt wurden. 

• Protected Content für Adobe Premiere Pro, After Effects, Encore, Soundbooth 
und OnLocation werden installiert, selbst wenn diese Anwendungen nicht für die 
Installation ausgewählt wurden. Es erscheint, als seien die Anwendungen installiert 
worden: Anwendungsordner werden unter Windows im Menü „Start“ oder unter Mac 
in den Anwendungsordnern angezeigt.  

• Beim Versuch, eine dieser Anwendungen zu starten, wird die Fehlermeldung 
angezeigt, dass die Anwendung nicht geöffnet werden kann, da sie nicht auf dieser 
Architektur unterstützt wird. (Nr. BG063851) 

• Weitere Informationen zur Installation finden Sie unter 
http://www.adobe.com/go/support_loganalyzer_de/. 

Hinweis: Nach der Erstinstallation benötigen Sie zum Installieren zusätzlicher Komponenten oder 
zum erneuten Installieren Ihrer Software Zugang zum ursprünglichen Installationsprogramm 
(CD, DVD oder Download aus dem Internet). Die Option „Reparieren“ ist nicht verfügbar. 
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Deinstallation der Software 

1. Schließen Sie vor der Deinstallation alle auf dem System derzeit ausgeführten 
Anwendungen, einschließlich anderer Adobe-Anwendungen, Microsoft Office-
Anwendungen und Browserfenstern.  

2. Führen Sie einen der folgenden Schritte durch:  
o Windows XP: Öffnen Sie die Windows-Systemsteuerung und doppelklicken Sie 

auf „Software“. Wählen Sie das Produkt, das Sie deinstallieren möchten, klicken 
Sie auf „Ändern/Entfernen“ und befolgen Sie die Anweisungen auf dem 
Bildschirm. 

o Windows Vista: Öffnen Sie die Windows-Systemsteuerung und doppelklicken Sie 
auf „Programme und Funktionen“. Wählen Sie das Produkt, das Sie 
deinstallieren möchten, klicken Sie auf „Deinstallieren/Ändern“ und befolgen Sie 
die Anweisungen auf dem Bildschirm.  

o WICHTIG: Mac OS verfügt über eine neue Deinstallationsfunktion. Verschieben 
Sie Anwendungen NICHT in den Papierkorb, um sie zu deinstallieren. Wenn Sie 
die Anwendung unter Mac OS X deinstallieren möchten, doppelklicken Sie unter 
„Programme/Dienstprogramme/Adobe Installers“ oder im Anwendungsordner auf 
den Alias „Deinstallieren“. Authentifizieren Sie sich als Administrator und 
befolgen Sie die Anweisungen auf dem Bildschirm. 

Bekannte Probleme 

• Beim Deinstallationsvorgang werden alle den installierten Anwendungsordnern 
hinzugefügten benutzerdefinierten Ordner gelöscht. (Nr. BG69109) 

• Beachten Sie, dass nach der Deinstallation von Creative Suite 4 einige Dateien auf 
Ihrem System verbleiben. 

 

Erwerb über eine Testversion 

Wenn Sie eine Testversion von Creative Suite 4 Production Premium installiert haben, können 
Sie eine Seriennummer eingeben, um von der Testversion zur zeitlich unbeschränkten Version 
zu wechseln. Eine Deinstallation ist nicht erforderlich. 

Sie können von einer Testversion zur zeitlich unbeschränkten Version wechseln, indem Sie die 
Seriennummer eingeben, die Sie beim Kauf von Production Premium erhalten haben. Starten Sie 
eine beliebige Production Premium-Anwendung und geben Sie die Seriennummer in das dafür 
vorgesehene Fenster ein. 

Andere Anwendungen, die als Bestandteil von Production Premium installiert wurden, erkennen 
die neue Seriennummer beim nächsten Start der jeweiligen Anwendung. Nur Anwendungen, 
die als Testversionen ausgeführt werden, erkennen die neue Seriennummer. Wenn eine der 
Anwendungen bereits mit einer anderen Seriennummer freigeschaltet wurde, verwendet die 
Anwendung weiterhin diese Seriennummer, bis Sie die ältere Seriennummer über die Option 
„Hilfe“ > „Deaktivieren“ > „Seriennummer löschen“ entfernen. Beim nächsten Start der 
Anwendung wird die neue Seriennummer erkannt. 
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Die erworbene Seriennummer gilt für die Verwendung der Software in einer bestimmten Sprache 
und wird nur von einem Produkt dieser Sprachversion akzeptiert. 

Kunden, die über eine Volumenlizenz verfügen, können das Produkt nicht direkt über eine 
Testversion kaufen. Die Seriennummer einer Volumenlizenz kann jedoch in der Testversion der 
Software eingegeben werden, ohne dass eine Deinstallation und Neuinstallation erforderlich ist. 
Wenden Sie sich an Ihren Händler oder ein autorisiertes Adobe-Lizenzcenter, um eine Bestellung 
für eine Volumenlizenz aufzugeben. Einen Händler in Ihrer Nähe finden Sie unter 
http://partners.adobe.com/resellerfinder/na/reseller.jsp. 

Elektronische Lizenzierung 
 
Die Verwendung dieses Produkts setzt voraus, dass Sie die in den Medien enthaltene 
Lizenzvereinbarung sowie die eingeschränkten Gewährleistungsbedingungen akzeptieren. 
Weitere Informationen finden Sie in der Software-Lizenzvereinbarung von Adobe. Die Software 
versucht u. U. automatisch, eine Aktivierung über das Internet durchzuführen. Mit Ausnahme von 
IP-Adressen, die in manchen Rechtsordnungen als persönliche Daten gelten, werden keine 
persönlichen Daten übermittelt. Weitere Informationen finden Sie auf der Website von Adobe 
unter www.adobe.com/go/activation_de. 
 
 
Hinweis: Wenn Sie ein Produkt auf einem anderen Computer installieren möchten, müssen Sie 
zuerst die Seriennummer auf Ihrem Computer deaktivieren. Wählen Sie dazu den Menübefehl 
„Hilfe“ > „Deaktivieren“. Die Deaktivierung einer Seriennummer gilt für alle Komponenten, die mit 
dieser Seriennummer aktiviert wurden. Wenn Sie ein Produkt nach der Deaktivierung auf 
demselben Computer starten, wird es erneut aktiviert. 
 
Registrierungsinformationen 

Sie sollten sich während der Installation der Software registrieren, um die aktuellsten 
Produktinformationen, Schulungen, Newsletter und Einladungen zu Adobe-Veranstaltungen und -
Seminaren zu erhalten. Wenn Sie sich bei der Installation nicht registrieren, können Sie sich stets 
später von einer beliebigen CS4-Komponente durch Auswahl von „Hilfe“ > „Registrierung“ 
registrieren. 

Installation von Schriftarten 

Das gesamte Dokumentationsmaterial zu Schriftarten ist online verfügbar. Unter 
http://www.adobe.com/go/cs4type_de finden Sie das OpenType-Benutzerhandbuch, die 
OpenType-Readme-Datei, Links zu Readme-Dateien bestimmter Schriftarten, Listen installierter 
Schriftarten der verschiedenen CS4-Produkte sowie Listen von Schriftarten, die auf der DVD der 
jeweiligen CS4-Produkte enthalten sind. 

Das Installationsprogramm der Creative Suite 4 installiert Schriftarten in ein dafür vorgesehenes 
Standardsystemverzeichnis. Viele dieser Schriftarten sind aktualisierte Versionen der von 
Creative Suite 3 installierten Schriften. Wenn das Installationsprogramm ältere Versionen dieser 
Schriftarten im Standardsystemverzeichnis findet, werden die älteren Versionen deinstalliert und 
in einem neuen Verzeichnis gespeichert. Das Standardsystemverzeichnis für Schriftarten lautet 
wie folgt: 

Apple Macintosh: <Systemlaufwerk>/Library/Fonts 

Windows: <Systemlaufwerk>:\Windows\Fonts 
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Die älteren Schriftarten werden im folgenden neuen Verzeichnis gespeichert: 

Apple Macintosh: <Systemlaufwerk>/Library/Application Support/Adobe/SavedFonts/current 

Windows: <Systemlaufwerk>:\Programme\Gemeinsame Dateien\Adobe\SavedFonts\current 

In diesem neuen Verzeichnis befindet sich auch eine Datei namens „Bitte lesen.html“, in der die 
gespeicherten Schriftarten und die Versionsnummern der neuen und alten Schriftdateien 
aufgeführt sind. 

Die älteren Schriftarten können erneut installiert werden, indem Sie die neuen Schriftdateien aus 
dem Standardsystemverzeichnis löschen und die alten Dateien dorthin zurück verschieben. 

Auf der Installations-DVD befinden sich weitere Schriftarten. Informationen zur Installation dieser 
Schriftarten erhalten Sie unter http://www.adobe.com/go/learn_fontinstall_de. 

Bekannte Probleme 

Aktuelle Produktinformationen und Informationen zu bekannten Problemen für alle Anwendungen 
von Creative Suite 4 erhalten Sie auf der Seite Adobe Support. 

GB18030-Unterstützung für Windows XP 

• Um die Anzeige aller Zeichen des chinesischen Standards GB18030 auf Windows XP-
Systemen zu unterstützen, empfiehlt Adobe die Installation des Microsoft GB18030-
Supportpakets. Mithilfe dieses Supportpakets werden XP-Systeme u. a. mit Schriftarten und 
Eingabemethoden-Editoren (Input Method Editor, IME) aktualisiert, mit denen GB18030 
unterstützt wird. Das Supportpaket kann von der Microsoft-Website heruntergeladen werden. 
(Nr. BG061690) 

Deaktivierung 

• Unter Windows kann die Deaktivierung unter Umständen fehlschlagen und die 
Fehlermeldung angezeigt werden, dass das Internet nicht gefunden wurde, selbst wenn eine 
Internetverbindung besteht. Wechseln Sie zu „Internetoptionen“ -> „Erweitert“, deaktivieren 
Sie „Auf gesperrte Serverzertifikate überprüfen“ und versuchen Sie erneut eine 
Deaktivierung. (Nr. BG056982) 

Suchen 

• „Suchen“ startet Internet Explorer, selbst wenn Firefox als Standardbrowser eingestellt 
wurde. (Nr. 1677521) 
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Soundbooth CS4 

• Das Doppelklicken zum Öffnen einer gespeicherten ASND-Datei in Soundbooth, die ein 
verknüpftes Asset enthält, führt dazu, dass die Komposition/Sequenz als offline angezeigt 
wird. Öffnen Sie die Datei „ASND“ mithilfe von „Datei“> „Öffnen“, statt doppelt zu klicken. 

OnLocation CS4 

• Wenn OnLocation unter Windows als Testversion installiert wurde, kann das Klicken auf die 
Schaltfläche „Beenden“ im Fenster für die Eingabe der Seriennummer beim 
Anwendungsstart dazu führen, dass OnLocation plötzlich geschlossen wird. Um dies zu 
umgehen, schließen Sie das Fenster für die Eingabe der Seriennummer durch Auswahl von 
„Datei“ > „Schließen“. (#BG070812) 

Kundenbetreuung 

Kundendienst 
Der Adobe-Kundendienst bietet Ihnen Unterstützung in Bezug auf Produktinformationen, Vertrieb, 
Registrierung und andere nicht-technische Probleme. Kontaktinformationen für den Adobe-
Kundendienst finden Sie auf der regionalen Website von Adobe.com.; klicken Sie hierzu auf 
„Kontakt“. 

Supportoptionen und technische Ressourcen  
Weitere Informationen zum technischen Support für ein Produkt einschließlich Informationen zu 
kostenlosen und kostenpflichtigen Supportplänen sowie zu Fehlerbehebungsressourcen finden 
Sie unter http://www.adobe.com/go/support_de/. Kunden außerhalb von Deutschland erhalten 
diese Informationen unter http://www.adobe.com/go/intlsupport_de/. Klicken Sie neben dem 
Ländernamen auf „Change“, um Ihr Land auszuwählen. 
 
Als kostenlose Ressourcen zur Problembehebung stehen unter anderem die Adobe-
Supportdatenbank, die Adobe-Benutzerforen und weitere Quellen zur Verfügung. Damit Sie 
Probleme flexibel und so schnell wie möglich lösen können, stellen wir online zusätzliche Tools 
und Informationen zur Verfügung. 

Sollten Sie beim Installieren oder Deinstallieren einer Creative Suite 4-Anwendung Probleme 
haben, versuchen Sie, das System erneut zu starten, bevor Sie sich an den Support wenden. 
Weitere Informationen zur Installation von CS4 finden Sie unter 
www.adobe.com/go/cs4install_de/. 
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Weitere Informationsquellen 

Dokumentation 
Sie können die gedruckte Dokumentation unter www.adobe.com/go/buy_books_de bestellen. 

Onlineressourcen 
 
Auf der Seite www.adobe.com/go/creativesuite4_community_help_de finden Sie umfangreiche 
Hilfe, Anleitungen, Ideen und Unterstützung von der Benutzer-Community. 
 
Sie können auch zu Bridge Home wechseln: 
Wählen Sie in einer beliebigen Creative Suite 4-Anwendung „Datei“ > „Durchsuchen“ > „Bridge“ 
aus. Wenn Bridge geöffnet ist, klicken Sie in der Leiste „Favoriten“ auf die Schaltfläche für Bridge 
Home. 
 
 
Adobe-Website 
Adobe TV 
Adobe Design Center  
Developer Center  
Benutzerforen 
Schulungen 
Adobe-Zertifizierungsprogramm 
Adobe-Partnerprogramme  
Adobe-Schulungspartner suchen 
Einen von Adobe autorisierten Druckdienstleister suchen 
 
 
Informationen zu den einzelnen Produkten 
  
Adobe Flash CS4 Professional  Adobe Bridge CS4 
  Bitte lesen   Neue Funktionen 

  Neue Funktionen    
        
Adobe Photoshop CS4 Extended Adobe Premiere Pro CS4  
  Bitte lesen   Bitte lesen 

  Neue Funktionen  Neue Funktionen 

        
Adobe After Effects CS4  Adobe Encore CS4 
  Bitte lesen   Bitte lesen  
  Neue Funktionen  Neue Funktionen   

        
Adobe Soundbooth CS4 Adobe OnLocation CS4  
  Bitte lesen  Bitte lesen 

  Neue Funktionen   Neue Funktionen  

        
Adobe Version Cue CS4 Adobe Device Central CS4 
  Bitte lesen  Bitte lesen 

  Neue Funktionen  Neue Funktionen 
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Benvenuti in Adobe® Creative Suite® 4 Production Premium. Questo documento contiene le informazioni più 
recenti sul prodotto, alcuni aggiornamenti e suggerimenti per la risoluzione dei problemi, che non sono inclusi 
nella documentazione di Creative Suite 4 Production Premium. 
 

Applicazioni di Creative Suite 4 Production Premium 
Requisiti minimi di sistema 
Installazione del software 
Disinstallazione del software 
Acquisto a partire dalla versione di prova 
Licenza elettronica 
Informazioni sulla registrazione 
Installazione dei caratteri 
Problemi noti 
Assistenza clienti 
Altre risorse 
Informazioni su singoli prodotti 
 

Applicazioni di Creative Suite 4 Production Premium 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4 (consente di accedere direttamente a Version Cue® e Adobe® Device Central) 
• Adobe Dynamic Link 
• Adobe Media Player 



 
 

Requisiti minimi di sistema 
 
Windows® 

• Processore da almeno 2 GHz per DV; 3,4 GHz per HDV; 2,8 GHz doppio per HD* 
• Microsoft® Windows® XP con Service Pack 2 (consigliato Service Pack 3) o Windows Vista® Home 

Premium, Business, Ultimate o Enterprise con Service Pack 1 (certificato per Windows XP e Windows 
Vista a 32 bit †) 

• 2 GB di RAM (ulteriore RAM consigliata per l'esecuzione simultanea di più applicazioni) 
• 16,3 GB di spazio libero su disco per l’installazione; ulteriore spazio libero necessario durante 

l’installazione (non può essere installato su dispositivi di memorizzazione basati su memoria flash) 
• Schermo da 1.280x900 con scheda grafica compatibile con OpenGL 2.0‡ 
• Supporto grafica per Shader Model 3.0 
• Disco rigido dedicato a 7200 RPM per l’editing DV e HDV; array di dischi con striping dei dati (RAID 0) 

per HD; preferibile l’utilizzo di un sottosistema di dischi SCSI 
• Per i flussi SD/HD, una scheda certificata da Adobe per l’acquisizione e l’esportazione su nastro‡ 
• Porta IEEE 1394 compatibile con OHCI per l’acquisizione da DV e HDV, l’esportazione su nastro e la 

trasmissione a un dispositivo DV 
• Unità DVD-ROM (masterizzatore DVD+-R per la creazione di DVD) 
• Masterizzatore Blu-ray per la creazione di dischi Blu-ray 
• Scheda audio Microsoft Windows Driver Model o compatibile con ASIO 
• QuickTime 7.4.5 richiesto per le funzioni QuickTime  
• I servizi online richiedono una connessione Internet a banda larga. 

 
*È necessario un processore abilitato per SSE2 per sistemi AMD 
 
† Adobe Photoshop Extended supporta in formato nativo le edizioni a 64 bit di Windows. Adobe Premiere Pro, 
After Effects, Soundbooth, Encore e Adobe OnLocation sono certificati su Windows Vista a 64 bit. Per 
informazioni sulla compatibilità di QuickTime con le edizioni a 64 bit di Windows, visitate il sito 
http://www.apple.com/it. 
 
Mac OS  

• Processore Intel® multicore 
• Mac OS X v10.4.11–10.5.4 
• Adobe Version Cue Server richiede Java™ Runtime Environment 1.5 
• 2 GB di RAM (ulteriore RAM consigliata per l'esecuzione simultanea di più applicazioni) 
• 20,6 GB di spazio libero sul disco rigido per l’installazione; ulteriore spazio su disco necessario durante 

l’installazione (non può essere installato su un volume con file system che fa distinzione tra maiuscole e 
minuscole o su dispositivi di memorizzazione basati su memoria flash) 

• Schermo da 1.280x900 con scheda grafica compatibile con OpenGL 2.0‡ 
• Alcune caratteristiche con accelerazione GPU richiedono supporto grafico per Shader Model 3.0 e 

OpenGL 2.0 
• Disco rigido dedicato a 7200 RPM per l’editing DV e HDV; array di dischi con striping dei dati (RAID 0) 

per HD; preferibile l’utilizzo di un sottosistema di dischi SCSI 
• Unità DVD-ROM (SuperDrive necessario per la creazione di DVD) 
• Masterizzatore Blu-ray per la creazione di dischi Blu-ray 
• Scheda audio compatibile con Core Audio 
• QuickTime 7.4.5 richiesto per le funzioni QuickTime  
• I servizi online richiedono una connessione Internet a banda larga. 

 
‡ Per aggiornamenti sui requisiti di sistema e informazioni più dettagliate sulla compatibilità dell'hardware video, 
visitate il sito http://www.adobe.com/go/production_systemreqs_it. 
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Questo prodotto potrebbe consentire l'accesso a determinate funzionalità online (“servizi online”), che richiedono 
una connessione Internet ad alta velocità. I servizi online e alcune loro funzioni potrebbero non essere disponibili 
per tutti i Paesi, in tutte le lingue o per tutte le valute. La loro disponibilità è inoltre soggetta a variazioni senza 
preavviso. L’uso dei servizi online è soggetto a termini e condizioni a parte e all’informativa sulla privacy online 
di Adobe. Potrebbe inoltre essere necessaria la registrazione da parte dell’utente. Alcuni servizi online, compresi 
quei servizi inizialmente forniti gratuitamente, possono essere soggetti a costi aggiuntivi. Per ulteriori dettagli e 
per consultare i termini e le condizioni di utilizzo nonché l’informativa sulla privacy online di Adobe, visitate 
www.adobe.com/it. 
 
Installazione del software 

1. Prima dell’installazione, chiudete tutte le applicazioni in esecuzione nel sistema, comprese altre 
applicazioni Adobe, Microsoft Office e le finestre dei browser. Durante l’installazione è inoltre consigliato 
disattivare temporaneamente la protezione antivirus. 

2. Sono richieste autorizzazioni amministrative o la convalida come amministratore. 
3. Effettuate una delle seguenti operazioni:  

Windows:  
o Inserite il DVD nell’unità e seguite le istruzioni visualizzate. Se il programma di installazione 

non viene avviato automaticamente, individuate la cartella Adobe CS4 nel livello principale del 
disco e fate doppio clic su Setup.exe per avviare l’installazione.  

o Se avete scaricato il software dal sito Web, aprite la cartella, individuate la cartella Adobe CS4, 
fate doppio clic su Setup.exe, quindi seguite le istruzioni visualizzate. 

Mac:  
o Inserite il DVD nell’unità e seguite le istruzioni visualizzate. Se il programma di installazione 

non viene avviato automaticamente, individuate la cartella dell’applicazione nel livello principale 
del disco, quindi fate doppio clic sul file Setup per avviare il processo di installazione.  

o Se avete scaricato il software dal sito Web, aprite la cartella, individuate la cartella 
dell’applicazione, fate doppio clic su Setup, quindi seguite le istruzioni visualizzate. 

4. Durante l’installazione di un aggiornamento il programma di installazione ricerca nel sistema un prodotto 
valido per l’aggiornamento. In caso di esito negativo, vi viene richiesto di immettere il numero di serie del 
prodotto da aggiornare. Potete inoltre installare il software come versione di prova e immettere in un 
secondo momento i numeri di serie (nuovo e precedente) nella schermata di serializzazione visualizzata 
all’avvio dell’applicazione. 

5. Per ulteriori informazioni sull'installazione di CS4, visitate il sito http://www.adobe.com/go/cs4install_it/. 

Problemi noti 

• In Mac OS, dopo l’installazione si nota un rallentamento delle prestazioni del sistema. Per risolvere 
questo problema, riavviate il sistema dopo l’installazione. (#BG063142) 

• In Mac OS non è possibile effettuare l’installazione nell’unità principale. (#BG044824) 

• Quando si installa un'applicazione a 32 bit su Vista a 64 bit, compare un percorso di installazione 
predefinito errato. L’applicazione viene comunque installata nel percorso corretto: 
c:\programmi(x86). (#BG064131) 

• Il valore di dimensione totale visualizzato nella schermata delle opzioni di installazione comprende 
lo spazio richiesto per alcuni componenti necessari per l’installazione, i quali non sono visualizzati 
nell’elenco dei componenti. Per questa ragione la dimensioni totale indicata potrebbe non 
corrispondere alla somma delle dimensioni dei componenti. (#BG059229) 
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• L’installazione può richiedere da 20 minuti a più di 1 ora, a seconda del prodotto e del numero di 
componenti da installare. (#BG050030) 

• Creative Suite 4 non può essere installato in una cartella cifrata. (#BG065106) 

• Anche se è possibile installare una versione di Creative Suite 4 in una partizione secondaria, per 
completare l'installazione il programma di installazione richiede comunque fino a 6 GB di spazio 
disponibile sulla partizione principale. La quantità di spazio disponibile necessario dipende dai 
componenti da installare. 

• Vengono installati contenuti protetti per Adobe Premiere Pro, After Effects, Encore, Soundbooth e 
OnLocation, anche se tali applicazioni non sono state selezionate per l'installazione. Potrebbe 
sembrare che le applicazioni siano state installate: le cartelle delle applicazioni appariranno nel 
menu Start di Windows o nella cartella Applicazioni del Mac. Tuttavia, dopo aver tentato di avviare 
una di queste applicazioni, verrà visualizzato un messaggio di errore in cui si informa l'utente che 
"Non è possibile aprire l'applicazione in quanto essa non è supportata in questa architettura." 
(#BG063851) 

• Per ulteriori informazioni sull’installazione, visitate http://www.adobe.com/go/support_loganalyzer_it. 

Nota: per installare componenti aggiuntivi o reinstallare il software dopo l’installazione originale, sarà 
necessario accedere al programma di installazione originale (su CD, DVD o scaricato dal Web). L’opzione 
Ripara non è disponibile. 

Disinstallazione del software 

1. Prima di effettuare la disinstallazione, chiudete tutte le applicazioni in esecuzione nel sistema, incluse 
altre applicazioni Adobe, applicazioni Microsoft Office e finestre del browser.  

2. Effettuate una delle seguenti operazioni:  
o In Windows XP aprite il Pannello di controllo e fate doppio clic su Installazione applicazioni. 

Selezionate il prodotto da disinstallare, fate clic su Cambia/Rimuovi, quindi seguite le istruzioni 
visualizzate. 

o In Windows Vista aprite il Pannello di controllo e fate doppio clic su Programmi e funzionalità. 
Selezionate il prodotto da disinstallare, fate clic su Disinstalla o Cambia, quindi seguite le 
istruzioni sullo schermo.  

o IMPORTANTE: in Mac OS è disponibile una nuova funzionalità di disinstallazione. Per 
disinstallare un’applicazione, NON trascinatela nel cestino. Per disinstallare correttamente 
un’applicazione in Mac OS X, fate doppio clic sull'alias di disinstallazione in 
Applicazioni\Utility\Adobe Installers o nella cartella Applicazione. Accedete come amministratore 
e seguite le istruzioni visualizzate. 

Problemi noti 

• Il processo di disinstallazione rimuoverà eventuali cartelle personalizzate aggiunte alle cartelle delle 
applicazioni installate. (#BG69109) 

• Dopo la disinstallazione di applicazioni Creative Suite 4, alcuni file continuano ad essere presenti 
nel sistema. 
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Acquisto a partire dalla versione di prova 

Se avete installato una versione di prova di Creative Suite 4 Production Premium, potete immettere un numero 
di serie per convertirlo da una versione di prova. Non è necessario eseguire la disinstallazione. 

Potete convertire una versione di prova immettendo il numero di serie che avete ricevuto al momento 
dell'acquisto di Production Premium. Avviate una delle applicazioni Production Premium e immettete il numero 
di serie nella schermata di serializzazione. 

Altre applicazioni installate come parte di Production Premium riconoscono, all’avvio, il nuovo numero di serie. 
Il nuovo numero di serie viene riconosciuto solo dalle applicazioni in esecuzione come versioni di prova. Se una 
delle applicazioni è già stata serializzata con un numero di serie diverso, continuerà a usare tale numero di serie 
fino a che non lo rimuoviate espressamente con il comando Aiuto > Disattiva > Cancella numero di serie. Al suo 
successivo avvio, tale applicazione riconoscerà il nuovo numero di serie. 

Il numero di serie acquistato è specifico per il software in una determinata lingua e viene accettato solo per 
un prodotto installato per tale lingua. 

I pacchetti multilicenza non possono essere acquistati direttamente da una versione di prova. Tuttavia è 
possibile inserire un numero di serie per pacchetto multilicenza nella versione di prova, senza dover disinstallare 
e reinstallare. Per inoltrare un ordine relativo a un contratto multilicenza, contattate il vostro rivenditore o un 
centro licenze Adobe autorizzato. Per trovare il rivenditore più vicino, visitate il sito Web 
http://partners.adobe.com/resellerfinder/na/reseller.jsp. 

Licenza elettronica 
 
Questo prodotto è soggetto all’accettazione del contratto di licenza fornito con il relativo supporto e ai termini di 
garanzia limitata. Per informazioni al riguardo consultate il contratto di licenza del software Adobe. Il software 
potrebbe tentare di effettuare l’attivazione via Internet. Con la procedura di attivazione non viene trasmesso 
alcun dato che consenta l’identificazione dell’utente, ad eccezione dell’indirizzo IP nella misura in cui questo sia 
considerato un dato identificativo in alcune giurisdizioni. Per ulteriori informazioni, visitate il sito Web di Adobe 
all’indirizzo http://www.adobe.com/go/activation_it/. 
 
 
Nota: per installare il prodotto su un altro computer, è opportuno disattivare prima il numero di serie nel 
computer in uso. Per disattivarlo, scegliete Aiuto > Disattiva. La disattivazione di un numero di serie si applica 
a tutti i componenti attivati con quel numero di serie. Se avviate un prodotto nello stesso computer dopo averlo 
disattivato, esso si attiverà di nuovo. 
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Informazioni sulla registrazione 

Al momento dell’installazione del software, di consiglia di effettuarne la registrazione per avere diritto a ricevere 
informazioni aggiornate sul prodotto, formazione, newsletter e inviti a eventi e seminari Adobe. Se non vi 
registrate al momento dell'installazione, potete sempre registrarvi in un secondo momento, dall'interno di 
qualsiasi componente di CS4, selezionando Aiuto > Registrazione. 

Installazione dei caratteri 

Tutta la documentazione relativa ai font è disponibile online. All’indirizzo www.adobe.com/go/cs4type_it/ potete 
trovare la guida utente OpenType, il documento Leggimi di OpenType, collegamenti a documenti Leggimi 
specifici per i font, elenchi dei font installati da diversi prodotti CS4 ed elenchi di font inclusi nel DVD per ogni 
prodotto CS4. 

Il programma di installazione di Creative Suite 4 installa i font in una directory di sistema predefinita. Molti di 
questi font sono delle nuove versioni dei font installati da Creative Suite 3. Se il programma di installazione trova 
le vecchie versioni di questi font nella directory dei font di sistema predefiniti, disinstalla le vecchie versioni e le 
salva in una nuova directory. La directory di sistema predefinita per i font è: 

Apple Macintosh:  <Disco di sistema>/Library/Fonts 

Windows: <Disco di sistema>:\Windows\Fonts 

I font precedenti vengono salvati nella seguente nuova directory: 

Apple Macintosh: <Disco di sistema>/Library/Application Support/Adobe/SavedFonts/current 

Windows: <Disco di sistema>:\Programmi\File comuni\Adobe\SavedFonts\current 

Questa nuova directory contiene inoltre il file Leggimi.html in cui sono elencati i font salvati e i numeri di versione 
dei file di font, sia nuovi che precedenti. 

Per reinstallare i font precedenti, eliminate i nuovi file di font dalla directory di sistema predefinita per i font 
e riportate in essa i font precedenti. 

Il disco di installazione contiene font aggiuntivi. Per informazioni su come installarli, consultate 
http://www.adobe.com/go/learn_fontinstall_it. 
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Problemi noti 

Per informazioni sempre aggiornate e problemi noti relativi a tutte le applicazioni Creative Suite 4, consultate il 
servizio di Adobe Support. 

Supporto GB18030 per Windows XP 

• Per supportare la visualizzazione di tutti i caratteri dello standard cinese GB18030 sui sistemi Windows XP, 
Adobe consiglia l'installazione del pacchetto Supporto Microsoft GB18030. Questo pacchetto di supporto 
aggiorna un sistema XP esistente con, tra l'altro, font ed editor del metodo di input (IME) per supportare 
correttamente GB18030. Il pacchetto di supporto è scaricabile dal sito Web Microsoft. (#BG061690) 

Disattivazione 

• Su Windows, la disattivazione potrebbe non riuscire, con la conseguente visualizzazione dell'errore "Internet 
non trovata", anche se una connessione Internet è presente. Passate a Opzioni Internet -> Avanzate, 
deselezionate "Verifica revoca dei certificati del server" e riprovate a effettuare la disattivazione. 
(#BG056982) 

Ricerca nella Guida 

• Se si effettua una ricerca nella guida, viene avviato Internet Explorer, anche se Firefox è stato impostato 
come browser predefinito. (#1677521) 

Soundbooth CS4 

• Facendo doppio clic per aprire un file ASND salvato in Soundbooth contenente una risorsa collegata, si 
otterrà la visualizzazione della composizione/sequenza in modalità non in linea. Per evitare che ciò accada, 
aprite il file ASND utilizzando File > Apri invece che facendo doppio clic. 

OnLocation CS4 

• In Windows, se OnLocation è stato installato come versione di prova, facendo clic sul pulsante Esci nella 
schermata di serializzazione all'avvio, OnLocation potrebbe chiudersi senza preavviso. Per evitare che ciò 
accada, chiudete la schermata di serializzazione scegliendo File > Chiudi dal menu File. (#BG070812) 
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Assistenza clienti 

L’assistenza clienti Adobe offre assistenza in merito a informazioni di prodotto, vendite, registrazione e altre 
questioni di natura non tecnica. Per le modalità di contatto del servizio clienti di Adobe, visitate il sito Adobe.com 
per il vostro Paese o la vostra regione geografica e fate clic su Contatti. 

Opzioni del programma di supporto e risorse tecniche  
Per ottenere assistenza tecnica per il prodotto in uso, incluse le informazioni sulle opzioni di supporto 
gratuito e a pagamento e sulle risorse per la risoluzione dei problemi, potete consultare il sito Web 
http://www.adobe.com/go/support_it/. Se non vi trovate in Nord America, visitate il sito 
http://www.adobe.com/go/intlsupport_it/ e fate clic su Change (Cambia) accanto al nome del Paese per 
selezionarne un altro. 
 
Le risorse gratuite per la risoluzione dei problemi comprendono la knowledgebase di supporto di Adobe, 
i forum degli utenti Adobe e molto altro. Gli strumenti e le informazioni disponibili online sono in continuo 
aggiornamento, per fornirvi opzioni flessibili per la risoluzione tempestiva di eventuali problemi. 

In caso di problemi durante l'installazione o la disinstallazione di un'applicazione della famiglia Creative Suite 4, 
provate a riavviare il sistema prima di contattare il Supporto. Per ulteriori informazioni sull'installazione di CS4, 
visitate il sito http://www.adobe.com/go/cs4install_it/. 

 
Altre risorse 

Documentazione 
Potete ordinare la documentazione stampata all'indirizzo http://www.adobe.com/go/buy_books_it. 

Risorse online 
 
Per una Guida completa e istruzioni, suggerimenti e assistenza forniti dalla comunità di utenti, visitate il sito 
http://www.adobe.com/go/creativesuite4_community_help_it/. 
 
Potete anche consultare Bridge Home: 
Da qualsiasi applicazione Creative Suite 4, scegliete File > Sfoglia… > Bridge. All'apertura di Bridge, fate clic sul 
pulsante Bridge Home nel pannello Preferiti. 
 
 
Sito Web di Adobe 
Adobe TV 
Adobe Design Center  
Developer Center  
Forum utenti 
Formazione 
Certificazioni Adobe 
Programmi per partner Adobe 
Ricerca di centri di formazione autorizzati Adober  
Ricerca di fornitori di servizi di stampa autorizzati Adobe 
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Adobe® 
 

Creative Suite 4 Production Premium お読みください 
 
Adobe® Creative Suite® 4 Production Premium をご利用いただき、ありがとうございます。本ドキュメントに

は、Creative Suite 4 Production Premium ユーザガイドに記載されていない最新の製品情報、アップデート、

トラブルシューティングのヒントに関する情報が記載されています。 
 

Creative Suite 4 Production Premium アプリケーション 
必要システム構成 
ソフトウェアのインストール 
ソフトウェアのアンインストール 
体験版からの購入 
ライセンス認証 
製品のユーザ登録 
フォントのインストール 
既知の問題 
サポートについて 
その他のリソース 
個々の製品情報 
 

Creative Suite 4 Production Premium アプリケーション 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4（Version Cue® および Adobe® Device Central に直接アクセス可能） 
• Adobe Dynamic Link 
• Adobe Media Player 

必要システム構成 
 
Windows® 

• 2 GHz 以上（HDV 再生には 3.4 GHz 以上、HD 再生には 2.8 GHz 以上かつデュアル構成）のプロ

セッサ*を搭載したパーソナルコンピュータ 
 *AMD プロセッサを搭載したシステムでは SSE2 対応が必須 
• Microsoft® Windows® XP（Service Pack 2）日本語版（Service Pack 3 を推奨）、または 

Windows Vista® Home Premium、Business、Ultimate、Enterprise（Service Pack 1）日本語

版（Windows XP 32 bit 版および Windows Vista 32 bit 版 / 64 bit 版で動作可能 †） 



 
 

• 2 GB 以上の RAM を推奨（複数のコンポーネントを使用するときは追加の RAM が必要） 
• 16.3 GB 以上の空き容量のあるハードディスク。ただし、インストール時には追加の空き容量が必要（フ

ラッシュメモリを利用したストレージデバイス上にはインストール不可） 
• 1,280 x 900 以上の画面解像度をサポートするディスプレイ、および OpenGL 2.0 対応のグラフィック

カード 
• GPU を利用する一部の機能では Shader Model 3.0 対応のグラフィックカードが必要 
• DV/HDV 用には 7,200 RPM 以上のハードディスク、HD 用には RAID 0 でストライピングされたディス

クアレイ（SCSI ディスクサブシステムを推奨） 
• SD/HD ワークフローには、キャプチャおよびテープへの書き出し用にアドビ認定のカード 
• DV および HDV キャプチャ、テープへの書き出し、DV デバイスへの伝送用に、OHCI IEEE 1394 ポー

ト 
• DVD-ROM ドライブ（DVD 作成には記録対応 DVD ドライブが必要） 
• Blu-ray ディスクの作成には記録対応 Blu-ray ドライブが必要 
• Microsoft WDM または ASIO 対応のオーディオインターフェイス 
• QuickTime 機能を利用するために QuickTime 7.4.5 日本語版  
• 付随するサービスのためにブロードバンドインターネット接続 

 
* AMD システムを利用するには SSE2 対応プロセッサが必要 
 
† Photoshop Extended は 64 bit 版対応の Windows Vista をネイティブにサポート。Adobe Premiere 
Pro、After Effects、Soundbooth、Encore、Adobe OnLocation は 64 bit 版対応の Windows Vista で
動作します。 
 
Mac OS  

• インテル® マルチコアプロセッサ 
• Mac OS X v10.4.11 - 10.5.4 
• Adobe Version Cue サーバを利用するには Java™ Runtime Environment 1.5 が必要 
• 2 GB 以上の RAM を推奨（複数のコンポーネントを使用するときは追加の RAM が必要） 
• 20.6 GB 以上の空き容量のあるハードディスク。ただし、インストール時には追加の空き容量が必要

（大文字と小文字が区別されるファイルシステムを使用している場合や、フラッシュメモリを利用したスト

レージデバイス上にはインストール不可） 
• 1,280 x 900 以上の画面解像度をサポートするディスプレイ、および OpenGL 2.0 対応のグラフィック

カード 
• GPU を利用する一部の機能では Shader Model 3.0 と OpenGL 2.0 対応のグラフィックカードが必

要 
• DV/HDV 用には 7,200 RPM 以上のハードディスク、HD 用には RAID 0 でストライピングされたディス

クアレイ（SCSI ディスクサブシステムを推奨） 
• DVD-ROM ドライブ（DVD 作成には SuperDrive が必要） 
• Blu-ray ディスクの作成には記録対応 Blu-ray ドライブが必要 
• Core Audio 対応のサウンドカード 
• QuickTime 機能を利用するため QuickTime® 7.4.5 日本語版  
• 付随するサービスのためにブロードバンドインターネット接続 

 
（※）ビデオハードウェアの互換性および詳細な必要システム構成については、

www.adobe.com/jp/products/creativesuite/production/systemreqs をご覧ください。 
 
ブロードバンドインターネット接続をご使用であれば、オンラインで提供される特定の機能（以下「オンラインサービ

ス」という）を本製品から利用できる場合があります。オンラインサービス、およびその機能は、国・地域、言語、通

貨によっては提供されていない場合があり、その全体または一部が予告なく中止となることもあります。オンライン

サービスのご利用には、個別の利用規約およびアドビのオンラインプライバシーポリシーが適用され、ユーザ登録が
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必要となります。当初は無償で提供されるサービスも含め、一部のオンラインサービスには、別途料金が発生する

場合があります。詳細情報ならびに利用規約とオンラインプライバシーポリシーを www.adobe.com/jp/ にてご確

認ください。 
 
※必要システム構成やアップグレード対象製品は予告無く変更となる場合がございます。ご購入前に必ずご確

認ください。 
 
ソフトウェアのインストール 

1. インストールする前に、他の Adobe アプリケーション、Microsoft Office アプリケーション、ブラウザウィン

ドウなど、システム上で実行しているすべてのアプリケーションを終了します。また、インストールが終了す

るまでウイルス対策ソフトウェアを一時的にオフにすることをお勧めします。 
2. インストールするには、管理者権限が必要です。または、管理者として認証できる必要があります。 
3. 次のいずれかの操作を行います。  

Windows：  
o ドライブに DVD を挿入し、画面の指示に従います。インストーラが自動的に起動しない場合

は、ディスクのルートレベルにある Adobe CS4 フォルダに移動し、Setup.exe をダブルクリック

してインストールを開始します。  
o Web からソフトウェアをダウンロードした場合は、フォルダを開き、Adobe CS4 フォルダに移動

します。次に、Setup.exe をダブルクリックして、画面の指示に従います。 

Mac OS：  
o ドライブに DVD を挿入して、Finder でコンテンツを表示します。インストールを開始するには、

Adobe CS4 Production Premium フォルダにある Setup をダブルクリックします。  
o Web からソフトウェアをダウンロードした場合は、フォルダを開き、アプリケーションフォルダに移動

します。次に、Setup をダブルクリックして、画面の指示に従います。 

4. アップグレード版をインストールする場合は、インストーラにより、有効なアップグレード対象製品がシステ

ム内で検索されます。見つからない場合は、アップグレード対象製品のシリアル番号を入力するようメッ

セージが表示されます。 
5. CS4 のインストールについて詳しくは、www.adobe.com/go/cs4install_jp をご覧ください。 

既知の問題 

• アプリケーションは初期設定の場所にインストールすることをお勧めします。インストールのパスに日

本語が含まれていると、製品の使用中に予期せぬ不具合が発生する場合があります。 

• Mac OS の場合、インストール後にシステムの動作が遅く感じられる場合があります。インストール

後にシステムを再起動することで、この問題は解決されます。（#BG063142） 

• Mac OS では、ルートドライブへのインストールはできません。（#BG044824） 

• 64 bit 版 Vista に 32 bit 版アプリケーションをインストールすると、正しくない初期設定のインストー

ル先が表示されますが、アプリケーションは正しい場所（c:\program files（x86））にインストールさ

れます。（#BG064131） 
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• インストーラのオプション画面に表示される「合計サイズ」には、コンポーネントリストには表示されな

い、インストール用コンポーネントの容量も含まれます。したがって、合計サイズの値は、コンポーネン

トリストのコンポーネントの合計値とは異なる場合があります。（#BG059229） 

• インストール時間は、インストールする製品および選択したコンポーネントの数に応じて 20 分から 
1 時間ぐらいかかります。（#BG050030） 

• Creative Suite 4 を暗号化されたフォルダにインストールできません。（#BG065106） 

• Creative Suite 4 のセカンダリパーティションへのインストールを選択できますが、その場合も、インス

トールを完了するにはプライマリパーティションに 6 GB の空き容量が必要になります。必要な空き

容量は、インストールするコンポーネントによって異なります。 

• Adobe Premiere Pro、After Effects、Encore、Soundbooth および OnLocation の保護さ

れたコンテンツは、これらのアプリケーションのインストールを選択していなくても、インストールされます。

アプリケーションフォルダが、Windows では「スタート」メニュー、Mac OS では「アプリケーション」フォ

ルダに表示され、アプリケーションがインストールされたように見えます。しかし、これらのアプリケーショ

ンを起動しようとすると、「アーキテクチャ上でサポートされていないので、このアプリケーションを開くこ

とはできません。」という内容のエラーメッセージが表示されます。（#BG063851） 

• インストール方法について詳しくは、http://www.adobe.com/go/support_loganalyzer_jp をご

覧ください。 

注意：追加のコンポーネントをインストールしたり、ソフトウェアを最初にインストールした後で再インストールする場

合は、元のインストーラ（CD、DVD または Web からのダウンロード）にアクセスする必要があります。修復オプショ

ンを使用することはできません。 

ソフトウェアのアンインストール 

1. アンインストールする前に、他の Adobe アプリケーション、Microsoft Office アプリケーション、ブラウザウ

ィンドウなど、システム上で実行しているすべてのアプリケーションを終了します。  
2. 次のいずれかの操作を行います。  

o Windows XP では、コントロールパネルを開き、「プログラムの追加と削除」をダブルクリックし

ます。アンインストールする製品を選択し、「変更と削除」をクリックして、画面の指示に従い

ます。 

o Windows Vista では、コントロールパネルを開き、「プログラムと機能」をダブルクリックします。

アンインストールする製品を選択し、「アンインストールと変更」をクリックして、画面の指示に従

います。  

o 重要：Mac OS には新しいアンインストール機能が搭載されています。アンインストールする際

に、アプリケーションをゴミ箱にドラッグしないでください。Mac OS X で安全にアンインストールを

行うには、アプリケーション/ユーティリティ/Adobe Installers またはアプリケーションフォルダで、ア

ンインストーラ用のエイリアスをダブルクリックします。管理者として認証を実行してから、画面の

指示に従います。 
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既知の問題 

• アンインストールプロセスにより、インストール済みのアプリケーションフォルダに追加したすべてのカスタ

ムフォルダは削除されます。（#BG69109） 

• Creative Suite 4 アプリケーションがアンインストールされた後も、システムから削除されないファイル

があります。 

 

体験版からの購入 

Creative Suite 4 Production Premium の体験版をインストールしている場合は、シリアル番号を入力して体

験版から製品版に変換することができます。体験版をアンインストールする必要はありません。 

Production Premium の購入時に入手したシリアル番号を入力して、体験版から製品版に変換します。

Production Premium アプリケーションを起動して、セットアップ画面でシリアル番号を入力します。 

新しいシリアル番号は、次回の起動時に Production Premium を構成する各アプリケーションに反映されます。

体験版として実行しているアプリケーションにのみ、新しいシリアル番号が反映されます。いずれかのアプリケーショ

ンで異なるシリアル番号が既に使用されている場合は、ヘルプ／ライセンス認証の解除を選択して古いシリアル

番号を削除するまで、そのシリアル番号が継続して使用されます。古いシリアル番号を削除した後でアプリケーショ

ンを初めて起動したときに、新しいシリアル番号が反映されます。 

購入したシリアル番号は、言語が限定され、その言語でインストールされた製品にのみ使用できます。 

ボリュームライセンスをご利用のお客様については、体験版からボリュームライセンスを直接購入することはできませ

ん。ただし、ボリュームライセンス用のシリアル番号は、アンインストールと再インストールをせずに、体験版の製品

で入力できます。ボリュームライセンスをお求めの場合は、アドビ製品取り扱い販売会社またはアドビライセンスセ

ンターまでお問い合わせください。最寄りの販売会社については、

http://partners.adobe.com/resellerfinder/na/reseller.jsp でご確認ください。 

ライセンス認証 
 
この製品をご利用いただくには、メディアに含まれている使用許諾契約書および限定責任の条件にご同意いただ

く必要があります。Adobe ソフトウェア使用許諾契約書をよくお読みください。ソフトウェアにより、インターネットを

介して自動的にライセンス認証が試行される場合があります。この手続きで個人を特定できる情報が送信される

ことはありません。ただし、IP アドレスが個人を特定できる情報だとみなされる地域については、これに該当しませ

ん。詳しくは、アドビ システムズ社の Web サイト（http://www.adobe.com/go/activation_jp）をご覧ください。 
 
 
注意：別のコンピュータに製品をインストールする場合は、まず使用中のコンピュータでシリアル番号のライセンス

認証を解除する必要があります。ライセンス認証を解除するには、ヘルプ／ライセンス認証の解除を選択します。

シリアル番号のライセンスの解除は、そのシリアル番号でライセンス認証が試行されたすべてのコンポーネントに適

用されます。ライセンス認証の解除の後に同じコンピュータ上で製品を起動する場合、再度ライセンス認証が行

われます。 
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製品のユーザ登録 

アドビ製品内からオンラインでユーザ登録されますと、テクニカルサポートが受けられるほかに、アドビストアでのご注

文やご購入履歴の参照、アドビ製品の登録や閲覧など、様々な特典、コンテンツやオンラインサービスをご利用

いただけます。お客様へスムーズで的確なサービスを提供させていただくために、ぜひ、ユーザ登録をお願いいたし

ます。インストール時に登録しない場合も、すべての CS4 コンポーネントでヘルプ／ユーザ登録を選択して、後で

いつでも登録できます。 

フォントのインストール 

フォント関連のすべてのドキュメントは、オンラインで提供されます。OpenType® のユーザガイドと「お読みくださ

い」、フォント別の「お読みください」、CS4 製品別にインストールされるフォントの一覧および CS4 製品別の 
DVD に含まれるフォントの一覧については、www.adobe.com/go/cs4type_jp のリンクを参照してください。 

Creative Suite 4 では、初期設定のシステムフォントディレクトリにフォントがインストールされます。これらのフォン

トの多くは、Creative Suite 3 でインストールされたバージョンの最新版です。初期設定のシステムフォントディレク

トリに古いバージョンのフォントが見つかると、古いバージョンは元の場所から削除されて新しいディレクトリに保存さ

れます。初期設定のシステムフォントディレクトリは次の場所になります。 

Mac OS：<システムディスク>/ライブラリ/Fonts 

Windows：<システムディスク>:\Windows\Fonts 

古いフォントは新しいディレクトリに保存されます。 

Mac OS：<システムディスク>/ライブラリ/Application Support/Adobe/SavedFonts/current 

Windows：<システムディスク>:\Program Files\Common Files\Adobe\SavedFonts\current 

この新しいディレクトリには、Read me.html ファイルも含まれます。このファイルは、保存したフォントと新旧フォント

ファイルのバージョン番号の一覧です。 

古いフォントを再インストールする場合は、初期設定のシステムフォントディレクトリから新しいフォントファイルを削

除し、古いファイルをそのディレクトリに戻します。 

インストールディスクには、追加のフォントが含まれています。追加フォントのインストール方法について詳しくは、

http://www.adobe.com/go/learn_fontinstall_jp を参照してください。 
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既知の問題 

Creative Suite 4 のすべてのアプリケーションに関する最新情報と既知の問題については、アドビ システムズ社の

サポートページをご覧ください。 

Windows XP での GB18030 使用に関するサポート   

• Windows XP システム上で中国語文字コード GB18030 のすべての文字を表示するために、Microsoft 
GB18030 サポートパッケージをインストールすることをお勧めします。 このサポートパッケージでは、GB 
18030 を正しくサポートするために、フォントと IME（Input Method Editor）などを含む XP システムが更新

されます。このサポートパッケージは Microsoft 社の Web サイトからダウンロードできます。（#BG061690） 

ライセンス認証の解除 

• Windows 上でライセンス認証の解除を行う場合、インターネットに接続していても「インターネットが見つかり

ません」という内容のエラーが表示され、解除が失敗する場合があります。インターネットオプション／詳細設

定に移動して、「サーバー証明書の取り消しを確認する」をチェック解除した後に、再度ライセンス認証の解

除を実行します。（#BG056982） 

ヘルプ検索 

• Firefox がデフォルトブラウザとして設定されている場合でも、ヘルプ検索は Internet Explorer 上で起動し

ます。 （#1677521） 

Soundbooth CS4 

• Soundbooth に保存された、リンクされたアセットを含む ASND ファイルをダブルクリックすると、コンポジション

およびシーケンスはオフラインとして表示されます。これを回避するには、ダブルクリックをせずに、ファイル／開く

を選択して ASND ファイルを開きます。 

OnLocation  CS4 

• OnLocation が体験版として Windows 上にインストールされている場合、起動時にセットアップ画面の「終

了」ボタンをクリックすると、OnLocation が予期せず終了してしまう場合があります。これを回避するには、フ

ァイルメニューからファイル／閉じるを選択して、セットアップ画面を閉じてください。（#BG070812） 
 

サポートについて 

製品のインストール情報、操作方法、トラブルシューティングに関する情報をご提供しておりますので、お問い合わ

せの前に、「サービス & サポート FAQ」（http://www.adobe.com/go/support_jp/）をご活用ください。 

 
STEP 1 ： お問い合わせいただく前に、「製品のユーザ登録」をお済ませください（「製品のユーザ登録」を参照く

ださい）。 
 
STEP 2 ： ご登録いただいた製品のシリアル番号をご用意ください。 
 
STEP 3 ： サポートへお問い合わせください。 
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ただし、無償インストールサポートには範囲ならびに回数制限があり、それを超えた場合は、「有償サポート」が必

要な場合もございますので、あらかじめご了承ください。なお、サポート範囲の詳細については、CS4 追加インス

トールのヘルプの詳細は、http://www.adobe.com/go/support_jp/ の「サポートプログラム」よりご確認ください。 
 
お問い合わせは、http://www.adobe.com/go/gn_contact_jp をご確認ください。 
 
その他のリソース 

ドキュメント 
ユーザガイド（印刷版）をお求めの際は、www.adobe.com/go/buy_books_jp から注文してください。 

オンラインリソース 

完全なヘルプ、地域に基づく説明、アイデアおよびサポートに関しては、

www.adobe.com/go/creativesuite4_community_help_jp を参照してください。 

 

Bridge Home への移動： 

いずれかの Creative Suite 4 アプリケーションから、ファイル／Bridge で参照...を選択します。Bridge が開いた

ら、お気に入りパネルで Bridge Home ボタンをクリックします。 

 
アドビ システムズ社の Web サイト
Adobe TV 
アドビデザインセンター  
デベロッパーセンター 
ユーザフォーラム 
トレーニング 
アドビ認定プログラム

アドビパートナープログラム  
アドビパートナーファインダー － トレーニングプロバイダー検索  
アドビパートナーファインダー － プリントサービスプロバイダー検索

アドビパートナーファインダー －ソリューションパートナー検索
 
 
個々の製品情報 
  
Adobe Flash CS4 Professional  Adobe Bridge CS4 
  お読みください   新機能

  新機能    
        
Adobe Photoshop CS4 Extended Adobe Premiere Pro CS4  
  お読みください   お読みください

  新機能  新機能
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Adobe After Effects CS4  Adobe Encore CS4 
  お読みください   お読みください  
  新機能  新機能

        
Adobe Soundbooth CS4 Adobe OnLocation CS4  
  お読みください  お読みください

  新機能   新機能

        
Adobe Version Cue CS4 Adobe Device Central CS4 
  お読みください  お読みください

  新機能  新機能

    
  
© 2008 Adobe Systems Incorporated.  All rights reserved. 
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Adobe®

 

Creative Suite 4 Production Premium 읽어보기 
 
Adobe® Creative Suite® 4 Production Premium 입니다. 이 문서에는 Creative Suite 4 Production 
Premium 설명서에서 다루지 않은 최신 제품 정보, 업데이트 및 문제 해결 팁 등이 나와 있습니다. 
 

Creative Suite 4 Production Premium 응용 프로그램 
최소 시스템 요구 사항 
소프트웨어 설치 
소프트웨어 제거 
시험 버전 설치 후 정식 버전을 구입한 경우 
전자 라이센스 
등록 정보 
글꼴 설치 
알려진 문제 
고객 지원 센터 
기타 리소스 
개별 제품 정보 
 

Creative Suite 4 Production Premium 응용 프로그램 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4(Version Cue® 및 Adobe® Device Central에 직접 액세스할 수 있는 
기능 제공) 

• Adobe Dynamic Link 
• Adobe Media Player 

최소 시스템 요구 사항 
 
Windows® 

• DV의 경우 2GHz 이상의 프로세서, HDV의 경우 3.4GHz 프로세서, HD의 경우 듀얼 
2.8GHz 프로세서* 

• Microsoft® Windows® XP 서비스 팩 2(서비스 팩 3 권장) 또는 Windows Vista® Home 
Premium, Business, Ultimate 또는 Enterprise 서비스 팩 1(32비트 버전의 Windows XP 및 
Windows Vista에 대해 인증됨†) 

• 2GB RAM (여러 개의 구성 요소를 실행할 경우 더 큰 용량의 RAM 권장) 



 
 

• 설치를 위한 16.3GB의 사용 가능한 하드 디스크 공간. 설치하는 동안 추가 여유 공간 
필요(플래시 기반 저장 장치에는 설치할 수 없음) 

• OpenGL 2.0 호환 그래픽 카드가 장착된 1,280x900 디스플레이‡ 
• Shader Model 3.0 그래픽 지원 
• DV 및 HDV 편집을 위한 전용 7200RPM 하드 드라이브, HD용 스트리핑된 디스크 배열 
저장 장치(RAID 0), SCSI 디스크 하위 시스템 권장 

• SD/HD 워크플로의 경우 캡처 및 테이프로 내보내기를 위한 Adobe 인증 카드‡ 
• DV 및 HDV 캡처, 테이프로 내보내기 및 DV 장치로 전송을 위한 OHCI 호환 IEEE 1394 
포트 

• DVD-ROM 드라이브(DVD 생성 시 DVD+-R 버너 필요) 
• 블루레이 디스크 생성 시 블루레이 버너 필요 
• Microsoft Windows Driver Model 또는 ASIO 호환 사운드 카드 
• QuickTime 기능 사용 시 QuickTime 7.4.5 필요  
• 온라인 서비스 이용 시 광대역 인터넷 연결 필요 

 
* AMD 시스템의 경우 SSE2 지원 프로세서 필요 
 
† Adobe Photoshop Extended는 64비트 버전의 Windows를 기본적으로 지원합니다. Adobe 
Premiere Pro, After Effects, Soundbooth, Encore 및 Adobe OnLocation은 64비트 버전의 
Windows Vista에 대해 인증되었습니다. QuickTime이 64비트 버전의 Windows와 호환되는지에 
대한 자세한 내용은 www.apple.com을 방문하십시오. 
 
Mac OS  

• 멀티코어 Intel® 프로세서 
• Mac OS X v10.4.11–10.5.4 
• Adobe Version Cue 서버에 Java™ Runtime Environment 1.5 필요 
• 2GB RAM (여러 개의 구성 요소를 실행할 경우 더 큰 용량의 RAM 권장) 
• 설치를 위한 20.6GB의 사용 가능한 하드 디스크 공간. 설치하는 동안 추가 하드 디스크 
공간 필요(대/소문자 구분 파일 시스템을 사용하는 볼륨 또는 플래시 기반 저장 장치에는 
설치할 수 없음) 

• OpenGL 2.0 호환 그래픽 카드가 장착된 1,280x900 디스플레이‡ 
• 일부 GPU 가속 기능의 경우 Shader Model 3.0 및 OpenGL 2.0 그래픽 지원 필요 
• DV 및 HDV 편집을 위한 전용 7200RPM 하드 드라이브, HD용 스트리핑된 디스크 배열 
저장 장치(RAID 0), SCSI 디스크 하위 시스템 권장 

• DVD-ROM 드라이브(DVD 디스크 생성 시 SuperDrive 필요) 
• 블루레이 디스크 생성 시 블루레이 버너 필요 
• Core Audio 호환 사운드 카드 
• QuickTime 기능 사용 시 QuickTime 7.4.5 필요  
• 온라인 서비스 이용 시 광대역 인터넷 연결 필요 

 
‡ 시스템 요구 사항에 대한 업데이트 내용 및 비디오 하드웨어 호환성에 대한 자세한 정보를 
보려면 http://www.adobe.com/go/production_systemreqs_kr를 방문하십시오. 
 
고속 인터넷 연결이 있는 경우 온라인으로 호스팅되는 일부 기능(“온라인 서비스”)에 액세스할 수 
있습니다. 일부 국가, 언어 및/또는 통화의 경우 온라인 서비스와 일부 관련 기능을 사용하지 못할 
수 있으며 통지 없이 일부 또는 전부가 중단될 수도 있습니다. 온라인 서비스의 사용에는 별도의 
약관과 Adobe 온라인 개인 정보 보호 정책이 적용되며 이러한 서비스에 액세스하려면 사용자 
등록이 필요할 수 있습니다. 일부 온라인 서비스에는 추가 요금이 부과될 수 있습니다(처음에 
무료로 제공되는 서비스 포함). 자세한 내용과 사용 약관 및 온라인 개인 정보 보호 정책을 
검토하려면 http://www.adobe.com/를 방문하십시오. 
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소프트웨어 설치 

1. 설치하기 전에 다른 Adobe 응용 프로그램, Microsoft Office 응용 프로그램, 브라우저 창 등 
시스템에서 현재 실행 중인 모든 응용 프로그램을 닫습니다. 또한 설치하는 동안에는 
바이러스 방지 기능을 일시적으로 해제하는 것이 좋습니다. 

2. 관리 권한이 있거나 관리자로서의 자격을 확인할 수 있어야 합니다. 
3. 다음 중 하나를 수행합니다.  

Windows:  
o 드라이브에 DVD를 넣고 화면의 지시를 따릅니다. 설치 관리자가 자동으로 
시작되지 않을 경우에는 디스크의 루트 수준에 있는 Adobe CS4 폴더로 이동한 
다음 Setup.exe를 두 번 클릭하여 설치 과정을 시작합니다.  

o 웹에서 소프트웨어를 다운로드한 경우 폴더를 열고 Adobe CS4 폴더로 이동하여 
Setup.exe를 두 번 클릭한 다음 화면의 지시를 따릅니다. 

Mac:  
o 드라이브에 DVD를 넣고 화면의 지시를 따릅니다. 설치 관리자가 자동으로 
시작되지 않을 경우에는 디스크의 루트 수준에 있는 응용 프로그램 폴더로 이동한 
다음 Setup Mac OS®를 두 번 클릭하여 설치 과정을 시작합니다.  

o 웹에서 소프트웨어를 다운로드한 경우 폴더를 열고 응용 프로그램 폴더로 
이동하여 Setup을 두 번 클릭한 다음 화면의 지시를 따릅니다. 

4. 업그레이드로 설치하는 경우 설치 관리자가 시스템을 확인하여 유효한 업그레이드 제품을 
찾습니다. 제품을 찾을 수 없는 경우에는 업그레이드할 제품의 일련 번호를 입력하라는 
메시지가 표시됩니다. 시험 버전으로 소프트웨어를 설치한 다음 시작될 때 표시되는 일련 
번호 등록 화면에 새 일련 번호와 이전 일련 번호를 입력할 수도 있습니다. 

5. CS4 설치에 대한 추가 도움말은 http://www.adobe.com/go/cs4install_kr/를 참조하십시오. 

알려진 문제 

• Mac의 경우 설치 후에 시스템 성능이 저하된 것처럼 보일 수 있습니다. 설치 후 
시스템을 다시 부팅하면 이 문제가 해결됩니다. (#BG063142) 

• Mac의 경우 루트 드라이브에 설치할 수 없습니다. (#BG044824) 

• 32비트 버전의 Windows Vista에 설치하는 경우 기본 설치 위치가 잘못 표시됩니다. 
응용 프로그램은 c:\program files(x86) 위치에 올바르게 설치됩니다. (#BG064131) 

• 설치 관리자 [옵션] 화면에 표시되는 “전체 크기”에는 설치에 필요하지만 구성 요소 
목록에는 표시되지 않는 구성 요소에 필요한 공간이 포함되기 때문에 값이 목록의 
구성 요소 크기와 일치하지 않을 수 있습니다. (#BG059229) 

• 제품 및 선택하여 설치하는 구성 요소의 수에 따라 설치 시간이 20분에서 1시간 
이상까지 소요될 수 있습니다. (#BG050030) 

• Creative Suite 4는 암호화된 폴더에 설치할 수 없습니다. (#BG065106) 
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• Creative Suite 4 버전을 부 파티션에 설치할 수는 있지만 설치를 완료하려면 주 
파티션에 최고 6GB의 여유 공간이 필요합니다. 필요한 여유 공간의 크기는 
설치하도록 선택한 구성 요소에 따라 달라집니다. 

• Adobe Premiere Pro, After Effects, Encore, Soundbooth 및 OnLocation의 보호된 
콘텐트는 해당 응용 프로그램을 설치하도록 선택하지 않은 경우에도 설치됩니다. 
따라서 Windows의 [시작] 메뉴 또는 Mac의 [응용 프로그램] 메뉴에 해당 응용 
프로그램 폴더가 표시됩니다. 그러나 이러한 응용 프로그램을 실행하려고 하면  
“응용 프로그램을 열 수 없습니다. 이 아키텍처에서는 해당 응용 프로그램을 열 수 
없습니다.”라는 오류 메시지가 표시됩니다. (#BG063851) 

• 설치에 대한 자세한 내용은 http://www.adobe.com/support/loganalyzer_kr/를 
참조하십시오. 

참고: 소프트웨어를 처음 설치한 이후 추가 구성 요소를 설치하거나 소프트웨어를 다시 
설치하려면 CD, DVD 또는 웹에서 다운로드한 원본 설치 관리자에 액세스해야 합니다.  
[복구]는 사용할 수 있는 옵션이 아닙니다. 

소프트웨어 제거 

1. 제거하기 전에 다른 Adobe 응용 프로그램, Microsoft Office 응용 프로그램, 브라우저 창 등 
시스템에서 현재 실행 중인 모든 응용 프로그램을 닫습니다.  

2. 다음 중 하나를 수행합니다.  
o Windows XP의 경우, Windows 제어판을 열고 [프로그램 추가/제거]를 두 번 
클릭합니다. 제거하려는 제품을 선택하고 [변경/제거]를 클릭한 다음 화면의 
지시를 따릅니다. 

o Windows Vista의 경우, Windows 제어판을 열고 [프로그램 및 기능]을 두 번 
클릭합니다. 제거하려는 제품을 선택하고 [제거/변경]을 클릭한 다음 화면의 
지시를 따릅니다.  

o 중요: Mac OS에 새 제거 기능이 추가되었습니다. 응용 프로그램을 휴지통에 
드래그하여 제거하지 마십시오. Mac OS X에서 응용 프로그램을 안전하게 
제거하려면 응용 프로그램/유틸리티/Adobe Installers 또는 응용 프로그램 
폴더에서 제거 앨리어스를 두 번 클릭합니다. 그런 다음 관리자로 인증한 후 
화면의 지시를 따릅니다. 

알려진 문제 

• 제거 프로세스에서는 설치된 응용 프로그램 폴더에 추가되어 있는 사용자 정의 폴더가 
모두 제거됩니다. (#BG69109) 

• Creative Suite 4 응용 프로그램을 제거하더라도 시스템에 일부 파일이 제거되지 않고 
남아 있을 수 있습니다. 
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시험 버전 설치 후 정식 버전을 구입한 경우 

Creative Suite 4 Production Premium 시험 버전을 설치한 후 정식 버전으로 전환하기 위해 일련 
번호를 입력할 수 있습니다. 이 경우 설치되어 있는 제품을 제거하지 않아도 됩니다. 

시험 버전을 정식 버전으로 전환하려면 Production Premium을 구입할 때 받은 일련 번호를 
입력하면 됩니다. 이렇게 하려면 Production Premium에 포함되어 있는 응용 프로그램 중 하나를 
실행한 다음 일련 번호 화면에서 일련 번호를 입력하면 됩니다. 

Production Premium 의 일부로 설치된 다른 응용 프로그램은 다음에 해당 응용 프로그램이 시작될 
때 새 일련 번호를 자동으로 인식합니다. 시험 버전으로 실행되는 응용 프로그램만 새 일련 번호를 
인식합니다. 응용 프로그램이 이미 다른 일련 번호로 등록된 경우 [도움말] > [비활성화] > [일련 
번호 지우기]를 사용하여 기존 일련 번호를 제거할 때까지 등록된 일련 번호가 계속 사용됩니다. 
기존 일련 번호를 제거한 후 응용 프로그램이 다음에 시작되면 새 일련 번호가 인식됩니다. 

구입한 일련 번호는 특정 언어의 소프트웨어를 사용하기 위한 것으로 해당 언어로 설치된 
제품에서만 허용됩니다. 

볼륨 라이센스 고객의 경우 시험 버전에서 바로 볼륨 라이센스를 구입할 수는 없지만 시험 버전을 
제거한 다음 다시 설치하지 않고 볼륨 라이센스 일련 번호를 입력하는 것은 가능합니다. 볼륨 
라이센스를 주문하려면 대리점이나 공인 Adobe 라이센스 센터에 문의하십시오. 가까운 대리점을 
찾으려면 http://partners.adobe.com/resellerfinder/na/reseller.jsp를 방문하십시오.

전자 라이센스 
 
이 제품은 미디어에 포함된 사용권 계약에 동의한 경우 제한 보증 약관에 따라 제공됩니다. 자세한 
내용은 Adobe 소프트웨어 사용권 계약을 참조하십시오. 소프트웨어에서 인터넷을 통해 자동으로 
활성화를 시도할 수 있습니다. 일부 관할지에서 IP 주소가 개인 식별이 가능한 정보로 간주될 수 
있는 경우를 제외하고 개인 식별이 가능한 어떠한 정보도 전송되지 않습니다. 자세한 내용은 
Adobe 웹 사이트 http://www.adobe.com/go/activation_kr를 참조하십시오. 
 
 
참고: 다른 컴퓨터에 제품을 설치하려면 현재 사용 중인 컴퓨터에서 먼저 소프트웨어를 
비활성화해야 합니다. 비활성화하려면 [도움말] > [비활성화]를 선택하십시오. 일련 번호를 
비활성화하면 해당 일련 번호를 사용하여 활성화된 모든 구성 요소에 이러한 변경 내용이 
적용됩니다. 비활성화한 후 같은 컴퓨터에서 제품을 실행하면 다시 활성화됩니다. 
 
등록 정보 

소프트웨어를 설치할 때 등록을 해야만 최신 제품 정보, 교육, 뉴스레터, Adobe 이벤트 및 세미나 
초대 등을 받을 수 있습니다. 설치할 때 등록하지 않은 경우에도 나중에 CS4 구성 요소에서 
[도움말] > [등록]을 선택하여 언제라도 등록할 수 있습니다. 

글꼴 설치 

글꼴과 관련된 모든 설명서는 온라인으로 제공됩니다. OpenType 사용 설명서, OpenType 
읽어보기, 글꼴 관련 읽어보기 링크, 여러 CS4 제품에서 설치하는 글꼴 목록, 각 CS4 제품 DVD에 
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포함된 글꼴 목록은 
http://www.adobe.com/type/browser/landing/creativesuite/creativesuite4.html을 참조하십시오. 

Creative Suite 4 설치 관리자는 기본 시스템 글꼴 디렉토리에 글꼴을 설치합니다. 이러한 글꼴 중 
다수는 Creative Suite 3에서 설치된 글꼴의 새로운 버전입니다. 설치 관리자가 기본 시스템 글꼴 
디렉토리에서 이러한 글꼴의 이전 버전을 발견하는 경우 이전 버전의 설치를 해제하고 해당 
파일을 새 디렉토리에 저장합니다. 기본 시스템 글꼴 디렉토리는 다음과 같습니다. 

    Apple Macintosh: <시스템 디스크>/Library/Fonts 

    Windows: <시스템 디스크>:\Windows\Fonts 

이전 글꼴은 다음과 같은 새 디렉토리에 저장됩니다. 

    Apple Macintosh: <시스템 디스크>/Library/Application Support/Adobe/SavedFonts/current 

    Windows: <시스템 디스크>:\Program Files\Common Files\Adobe\SavedFonts\current 

이와 같은 새 디렉토리에는 저장된 글꼴과 새 글꼴 파일 및 이전 글꼴 파일의 버전 번호가 나와 
있는 “Read Me.html” 파일도 포함됩니다. 

기본 시스템 글꼴 디렉토리에서 새 글꼴 파일을 삭제하고 이전 파일을 다시 기본 시스템 글꼴 
디렉토리로 이동하면 이전 글꼴을 다시 설치할 수 있습니다. 

설치 디스크에 추가 글꼴이 있습니다. 이러한 글꼴의 설치에 대한 자세한 내용은 
http://www.adobe.com/go/learn_fontinstall_kr을 참조하십시오. 

알려진 문제 

모든 Creative Suite 4 응용 프로그램의 최신 정보 및 알려진 문제에 대한 자세한 내용은 Adobe 
지원을 참조하십시오. 

Windows XP에 대한 GB18030 지원 

• Windows XP 시스템에서 모든 중국어 표준 GB18030 문자의 표시를 지원하려면 Microsoft 
GB18030 Support Package를 설치하는 것이 좋습니다. 이 지원 패키지는 GB18030을 
올바르게 지원하기 위해 글꼴과 입력기(IME) 등으로 XP 시스템을 업데이트합니다. 지원 
패키지는 Microsoft 웹 사이트에서 다운로드로 사용할 수 있습니다. (#BG061690) 

비활성화 

• Windows에서 인터넷이 연결되어 있음에도 불구하고 비활성화하면 “인터넷에 연결되어 있지 
않습니다.”라는 오류 메시지가 표시될 수 있습니다. 이 문제를 해결하려면 [인터넷 옵션] > 
[고급]으로 이동한 다음 [서버 인증서 해지 확인]의 선택을 취소한 후 다시 비활성화하면 
됩니다. (#BG056982) 
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도움말 검색 

• FireFox가 기본 브라우저로 설정되어 있음에도 불구하고 도움말 검색을 하면 Internet 
Explorer가 실행됩니다. (#1677521) 

Soundbooth CS4 

• 링크된 에셋을 포함하는 저장된 ASND 파일을 Soundbooth에서 두 번 클릭하여 열면 
구성/시퀀스가 오프라인으로 표시됩니다. 이 문제를 해결하려면 ASND 파일을 두 번 클릭하여 
열지 말고 [파일] > [열기]를 사용하여 열면 됩니다. 

OnLocation CS4 

• Windows에서 OnLocation을 시험 버전으로 설치한 경우 실행 시 일련 번호 화면에서 [종료] 
단추를 클릭하면 OnLocation이 예기치 않게 종료됩니다. 이 문제를 해결하려면 [파일] > 
[닫기]를 선택하여 일련 번호 화면을 닫으면 됩니다. (#BG070812) 

고객 지원 센터 

고객 서비스 
Adobe 고객 서비스에서는 제품 정보, 판매, 등록 및 기타 비기술적 문제에 대한 지원을 제공합니다. 
Adobe 고객 서비스로 연락하는 방법을 알아보려면 해당 지역 또는 국가의 Adobe 웹 사이트를 
방문하여 [연락처]를 클릭하십시오. 

지원 계획 옵션 및 기술 리소스  
무료 및 유료 지원 계획에 대한 정보를 비롯하여 제품에 대한 기술적인 지원이 필요한 경우에는 
http://www.adobe.com/go/support_kr/에서 추가 정보를 얻을 수 있습니다. 북미 지역 사용자가 
아닌 경우에는 http://www.adobe.com/go/intlsupport_kr/로 이동하여 국가 이름 옆의 [변경]을 
클릭하면 사용자의 지역을 선택할 수 있습니다. 
 
무료 문제 해결 리소스에는 Adobe의 지원 지식기반, Adobe 사용자 포럼 등이 있습니다. 사용자의 
문제를 가능한 한 신속하게 해결할 수 있도록 유연한 옵션을 제공하기 위해 추가 도구 및 정보가 
온라인에 계속 추가되고 있습니다. 

Creative Suite 4 응용 프로그램의 설치 또는 제거에 문제가 있는 경우 지원 센터에 연락하기 전에 
시스템을 다시 부팅해 보십시오. CS4 설치에 대한 추가 도움말은 
www.adobe.com/go/cs4install_kr/를 참조하십시오. 

 
기타 리소스 

설명서 
인쇄된 설명서는 www.adobe.com/go/buy_books_kr에서 구입할 수 있습니다. 
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온라인 리소스 
전체 도움말과 커뮤니티 기반 지침, 아이디어 및 지원은 
www.adobe.com/go/creativesuite4_community_help_kr를 참조하십시오.

또한 다음과 같은 방법을 사용하여 Bridge 홈으로 이동할 수 있습니다. 

Creative Suite 4 응용 프로그램에서 [파일] > [찾아보기...] > [Bridge]를 선택합니다. Bridge가 
열리면 [즐겨찾기] 창에서 [Bridge 홈] 단추를 클릭합니다.

 
 
Adobe 웹 사이트
Adobe TV 
Adobe Design Center  
개발자 센터 
사용자 포럼 
트레이닝 
Adobe 인증 프로그램
Adobe 파트너 프로그램
Adobe 공인 교육 센터 찾기
Adobe 공인 인쇄 서비스 공급자 찾기
 
 
개별 제품 정보 
  
Adobe Flash CS4 Professional  Adobe Bridge CS4 
  읽어보기   새로운 기능
  새로운 기능    
        
Adobe Photoshop CS4 Extended Adobe Premiere Pro CS4  
  읽어보기   읽어보기

  새로운 기능  새로운 기능
        
Adobe After Effects CS4  Adobe Encore CS4 
  읽어보기   읽어보기  
  새로운 기능  새로운 기능
        
Adobe Soundbooth CS4 Adobe OnLocation CS4  
  읽어보기  읽어보기

  새로운 기능   새로운 기능
        
Adobe Version Cue CS4 Adobe Device Central CS4 
  읽어보기  읽어보기

  새로운 기능  새로운 기능
    
  
© 2008 Adobe Systems Incorporated. All rights reserved. 
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Léame de Creative Suite 4 Production Premium 
 
Bienvenido a Adobe® Creative Suite® 4 Production Premium. Este documento contiene 
información de última hora, actualizaciones y sugerencias para la resolución de problemas 
no incluidas en la documentación de Creative Suite 4 Production Premium. 
 

Aplicaciones de Creative Suite 4 Production Premium 
Requisitos mínimos del sistema 
Instalación del software 
Desinstalación del software 
Adquisición a partir de una versión de prueba 
Licencia electrónica 
Información de registro 
Instalación de fuentes 
Problemas conocidos 
Asistencia a clientes 
Otros recursos 
Información de producto individual 
 

Aplicaciones de Creative Suite 4 Production Premium 

• Adobe Photoshop® CS4 Extended 
• Adobe Illustrator® CS4 
• Adobe Flash® CS4 Professional 
• Adobe After Effects® CS4 
• Adobe Premiere® Pro CS4  
• Adobe Soundbooth® CS4 
• Adobe OnLocation™ CS4  
• Adobe Encore® CS4 
• Adobe Bridge CS4 (ofrece acceso directo a Version Cue® y Adobe® Device Central) 
• Adobe Dynamic Link 
• Adobe Media Player 



 
 

Requisitos mínimos del sistema 
 
Windows® 

• Procesador de 2 GHz o más rápido para DV;3,4 GHz para HDV; dual 2,8 GHz para HD* 
• Microsoft® Windows® XP con Service Pack 2 (se recomienda Service Pack 3) o 

Windows Vista® Home Premium, Business, Ultimate o Enterprise con Service Pack 1; 
(certificado para las ediciones de 32 bits de Windows XP y Windows Vista†) 

• 2 GB de RAM (se recomienda más RAM cuando se ejecuten componentes múltiples) 
• 16,3 GB de espacio libre en el disco duro para la instalación; se necesitará espacio libre 

adicional durante la instalación (no se puede instalar en dispositivos de almacenamiento 
basados en memoria flash). 

• Resolución de monitor mínima de 1.280 x 900 con tarjeta gráfica compatible con 
OpenGL 2.0‡ 

• Soporte gráfico para Shader Model 3.0 
• Disco duro de 7.200 RPM destinado a la edición de DV y HDV; almacenamiento de la 

matriz de disco de paridad (RAID 0) para HD; se prefiere el subsistema de disco SCSI 
• Para flujos de trabajo SD/HD, una tarjeta certificada por Adobe para la captura y 

exportación a cinta‡ 
• Puerto IEEE 1394 compatible con OHCI para la captura de DV y HDV, exportación a 

cinta y transmisión al dispositivo DV 
• Unidad de DVD-ROM (se requiere una grabadora DVD+-R para crear DVD) 
• Se requiere una grabadora Blu-ray para crear discos Blu-ray 
• Tarjeta de sonido compatible con Microsoft Windows Driver Model o ASIO 
• Se requiere el software QuickTime 7.4.5 para usar las funciones de QuickTime  
• Se requiere una conexión a Internet de banda ancha para los servicios en línea 

 
*Se necesita un procesador con SSE2 para los sistemas AMD 
 
† Adobe Photoshop Extended admite en principio las ediciones de 64 bits de Windows. Adobe 
Premiere Pro, After Effects, Soundbooth, Encore y Adobe OnLocation están certificados para 
Windows Vista de 64 bits. Visite http://www.apple.com/es para obtener información sobre la 
compatibilidad de QuickTime con las ediciones de 64 bits de Windows. 
 
Mac OS  

• Procesador Intel® multinúcleo 
• Mac OS X v10.4.11–10.5.4 
• Se precisa Java™ Runtime Environment 1.5 para Adobe Version Cue Server 
• 2 GB de RAM (se recomienda más RAM cuando se ejecuten componentes múltiples) 
• 20,6 GB de espacio libre en el disco duro para la instalación; se necesitará espacio libre 

adicional durante la instalación (no se puede instalar en un volumen que use un sistema 
de archivos que distinga entre mayúsculas y minúsculas o en un dispositivo de 
almacenamiento basado en flash) 

• Resolución de monitor mínima de 1.280 x 900 con tarjeta gráfica compatible con 
OpenGL 2.0‡ 

• Algunas funciones aceleradas de la GPU requieren soporte gráfico para Shader Model 
3.0 y OpenGL 2.0 

• Disco duro de 7.200 RPM destinado a la edición de DV y HDV; almacenamiento de la 
matriz de disco de paridad (RAID 0) para HD; se prefiere el subsistema de disco SCSI 

• Unidad de DVD-ROM (se requiere SuperDrive para crear DVD) 
• Se requiere una grabadora de Blu-ray para crear discos Blu-ray 
• Tarjeta de sonido compatible con Core Audio 
• Se requiere el software QuickTime 7.4.5 para usar las funciones de QuickTime  
• Se requiere una conexión a Internet de banda ancha para los servicios en línea 
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‡ Para obtener información actualizada y más detallada sobre los requisitos del sistema y la 
compatibilidad con hardware de vídeo, visite 
http://www.adobe.com/go/production_systemreqs_es. 
 
Este producto le puede permitir acceder a ciertas funciones que se alojan en línea ("servicios en 
línea"), siempre que tenga una conexión a Internet de alta velocidad. Puede que los servicios en 
línea y, por lo tanto, algunas funciones, no estén disponibles en todos los países, idiomas o 
divisas o que estén incompletos de forma parcial o total sin previo aviso. El uso de los servicios 
en línea está regido por unos términos de uso independientes, así como por la política de 
privacidad en línea de Adobe. Puede que necesite registrarse para acceder a estos servicios. 
Algunos servicios en línea, incluidos aquellos servicios que en un principio se ofrezcan sin cargo 
alguno, pueden estar sujetos a tasas adicionales. Para obtener más información y consultar los 
términos de uso y la política de privacidad en línea, visite http://www.adobe.com/es. 
 
Instalación del software 

1. Antes de comenzar la instalación, cierre todas las aplicaciones que se estén ejecutando 
en el sistema, incluidas las aplicaciones de Adobe y Microsoft Office y las ventanas del 
navegador. También se recomienda desactivar temporalmente el antivirus durante el 
proceso de instalación. 

2. Es necesario que tenga privilegios de administrador o que pueda validar como tal. 
3. Realice una de las siguientes acciones:  

Windows:  
o Introduzca el DVD en su unidad y siga las instrucciones que aparecen en 

la pantalla. Si el programa de instalación no se ejecuta automáticamente, 
desplácese hasta la carpeta Adobe CS4 que se encuentra en la raíz de su disco 
y haga doble clic en el archivo Setup.exe para iniciar el proceso de instalación.  

o Si ha descargado el software desde la página Web, abra la carpeta, desplácese 
hasta la carpeta Adobe CS4, haga doble clic en el archivo Setup.exe y, a 
continuación, siga las instrucciones que aparecen en la pantalla. 

Macintosh:  
o Introduzca el DVD en su unidad y siga las instrucciones que aparecen en 

la pantalla. Si el programa de instalación no se ejecuta automáticamente, 
desplácese hasta la carpeta de la aplicación que se encuentra en la raíz de 
su disco y haga doble clic en Setup (Mac OS®) para iniciar el proceso de 
instalación.  

o Si ha descargado el software desde la página Web, abra la carpeta, desplácese 
hasta la carpeta de aplicación, haga doble clic en el archivo Setup y, a 
continuación, siga las instrucciones que aparecen en la pantalla. 

4. Si está instalando una actualización, el programa de instalación comprobará el sistema 
para buscar un producto de actualización válido. Si no lo encuentra, le pedirá que 
escriba el número de serie del producto que desea actualizar. También puede instalar el 
software de prueba y, a continuación, escribir el número de serie antiguo y el nuevo en la 
pantalla de serialización que aparecerá cuando inicie la aplicación. 

5. Para obtener ayuda adicional sobre la instalación de CS4, vaya a 
http://www.adobe.com/go/cs4install_es/. 
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Problemas conocidos 

• Puede que tras instalar el programa en un Mac, tenga la sensación de que el 
sistema va más lento. Para solucionarlo, reinicie el sistema después de la 
instalación. (#BG063142) 

• En Mac, no se puede instalar el programa en la unidad raíz. (#BG044824) 

• Al instalar la aplicación de 32 bits en Windows Vista de 64 bits, aparece una 
ubicación predeterminada de instalación incorrecta. La aplicación se instalará en la 
ubicación correcta: C:\Archivos de programa (x86). (#BG064131) 

• La opción "Tamaño total" que aparece en la pantalla Opciones del programa de 
instalación incluye el espacio que requieren los componentes necesarios para la 
instalación que no aparecen en la lista de componentes, por lo que puede que el 
número total no se corresponda con el tamaño de los componentes de la lista. 
(#BG059229) 

• La instalación dura de 20 minutos a más de 1 hora dependiendo del producto y del 
número de componentes que se vayan a instalar. (#BG050030) 

• Creative Suite 4 no se puede instalar en una carpeta cifrada. (#BG065106) 

• Aunque puede elegir instalar una edición de Creative Suite 4 en una partición 
secundaria, el instalador requiere hasta 6 GB de espacio libre disponible en la 
partición primaria para completar la instalación. La cantidad necesaria de espacio 
libre depende de los componentes escogidos para instalar. 

• Algunos contenidos protegidos para Adobe Premiere Pro, After Effects, Encore, 
Soundbooth y OnLocation se instalarán aunque dichas aplicaciones no se hayan 
seleccionado para la instalación. Aparecerá como si las aplicaciones se hubiesen 
instalado: aparecerán carpetas de aplicación en el menú Inicio de Windows o en la 
carpeta Aplicaciones de Mac. Sin embargo, al intentar ejecutar una de estas 
aplicaciones, aparecerá un mensaje en el que se indica que "No puede abrir la 
aplicación porque no se admite en esta arquitectura". (#BG063851) 

• Para obtener información más detallada acerca de la instalación, vaya a 
http://www.adobe.com/go/support_loganalyzer_es. 

Nota: después de la instalación original, para instalar componentes adicionales o volver a instalar 
el software, necesitará el programa de instalación original (CD, DVD o descarga desde Internet). 
La opción de reparación no está disponible. 
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Desinstalación del software 

1. Antes de comenzar la desinstalación, cierre todas las aplicaciones que se estén 
ejecutando en el sistema, incluidas las aplicaciones de Adobe y Microsoft Office, 
así como las ventanas del navegador.  

2. Realice una de las siguientes acciones:  
o En Windows XP, abra el Panel de control y haga doble clic en Agregar o quitar 

programas. Seleccione el producto que desea desinstalar, haga clic en Cambiar 
o quitar y, a continuación, siga las instrucciones que aparecen en la pantalla. 

o En Windows Vista, abra el Panel de control, Programas y haga doble clic en 
Programas y características. Seleccione el producto que desea desinstalar, 
haga clic en Desinstalar o Cambiar y, a continuación, siga las instrucciones 
que aparecen en la pantalla.  

o IMPORTANTE: Mac OS incluye una nueva función de desinstalación. NO 
arrastre las aplicaciones a la papelera para desinstalarlas. Para desinstalar 
correctamente las aplicaciones en Mac OS X, haga doble clic en el alias de 
desinstalación ubicado en Aplicaciones/Utilidades/Adobe Installers o en la 
carpeta de la aplicación. Regístrese como administrador y, a continuación, 
siga las instrucciones que aparecen en la pantalla. 

Problemas conocidos 

• El proceso de desinstalación eliminará todas las carpetas personales añadidas a las 
carpetas de la aplicación instalada. (#BG69109) 

• Observe que algunos archivos permanecerán en su sistema después de desinstalar 
algunas aplicaciones de Creative Suite 4. 

 

Adquisición a partir de una versión de prueba 

Si ha instalado una versión de prueba de Creative Suite 4 Production Premium, puede introducir 
el número de serie para convertirla. No es necesario desinstalar. 

Puede convertir una versión de prueba introduciendo el número de serie que recibió al adquirir 
Production Premium. Ejecute cualquier aplicación de Production Premium e introduzca el número 
de serie en la pantalla de serialización. 

Las demás aplicaciones que estén instaladas como parte de Production Premium reconocerán el 
nuevo número de serie la próxima vez que se ejecuten. Solamente las aplicaciones que se 
ejecuten en modo de prueba reconocerán el nuevo número de serie. Si ya se ha serializado 
alguna de las aplicaciones con un número de serie diferente, ésta seguirá usando ese número de 
serie hasta que se elimine el antiguo. Para ello, vaya a Ayuda > Desactivar > Borrar el número 
de serie. Cuando vuelva a iniciar la aplicación, ésta reconocerá el nuevo número de serie. 

El número de serie que ha adquirido se usa para el software en un idioma específico y, por lo 
tanto, sólo lo aceptará un producto que esté instalado en ese idioma. 
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Los clientes con licencia no pueden adquirir directamente una licencia por volumen a partir de la 
versión de prueba. Sin embargo, se puede introducir el número de serie de una licencia por 
volumen en el software de prueba sin tener que desinstalar o reinstalar. Póngase en contacto 
con su proveedor o con el centro autorizado de licencias de Adobe para realizar el pedido de una 
licencia por volumen. Para encontrar un proveedor en su zona, vaya a 
http://partners.adobe.com/resellerfinder/na/reseller.jsp. 

Licencia electrónica 
 
La oferta de este producto está sujeta a la aceptación del contrato de licencia incluido en el 
producto y a unos términos de garantía limitados. Para obtener información más detallada, 
consulte el contrato de licencia del software de Adobe. Puede que el software intente activarse 
automáticamente a través de Internet. No se transmitirá ningún tipo de información personal 
identificable, salvo que las direcciones IP puedan considerarse como una información personal 
identificable en algunas jurisdicciones. Para obtener más información, visite la sección 
http://www.adobe.com/go/activation_es del sitio Web de Adobe. 
 
 
Nota: si desea instalar un producto en un ordenador distinto, en primer lugar debe desactivar el 
número de serie en su ordenador. Para ello, seleccione Ayuda > Desactivar. La desactivación del 
número de serie afectará a todos los componentes activados con dicho número. Si ejecuta un 
producto en el mismo ordenador después de haberlo desactivado, se activará de nuevo. 
 
Información de registro 

Una vez instalado el software, asegúrese de completar el proceso de registro para poder obtener 
información actualizada del producto, formación, boletines de noticias o invitaciones a eventos y 
seminarios de Adobe. Si no se registra al instalar el programa, siempre puede hacerlo más tarde 
desde cualquier componente CS4 seleccionando Ayuda > Registro. 

Instalación de fuentes 

Toda la documentación relacionada con las fuentes está en línea. Visite 
http://www.adobe.com/es/type/browser/landing/creativesuite/creativesuite4.html para consultar la 
Guía de usuario de OpenType, el archivo Léame de OpenType, enlaces a archivos Léame 
relacionados con las fuentes, listas de las fuentes instaladas en los diversos productos CS4 y 
listas de las fuentes incluidas en el DVD para cada uno de los productos CS4. 

El programa de instalación de Creative Suite 4 instala fuentes en un directorio de fuentes de 
sistema predeterminado. Muchas de estas fuentes son versiones más recientes de fuentes 
instaladas por Creative Suite 3. Si el programa de instalación encuentra versiones anteriores de 
estas fuentes en el directorio de fuentes de sistema predeterminado, desinstala las versiones 
más antiguas y las guarda en un nuevo directorio. El directorio de fuentes de sistema 
predeterminado es: 

Apple Macintosh: <Disco del sistema>/Librería/Fonts 

Windows: <Disco del sistema>:\Windows\Fonts 
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Las fuentes más antiguas se guardan en el nuevo directorio: 

Apple Macintosh: <Disco del sistema>/Library/Application Support/Adobe/SavedFonts/current 

Windows: <Disco del sistema>:\Archivos de programa\Archivos 
comunes\Adobe\SavedFonts\current 

Este nuevo directorio contendrá un archivo "Read Me.html" que muestra las fuentes guardadas y 
los números de versión de los archivos de fuentes antiguos y nuevos. 

Puede volver a instalar las fuentes antiguas borrando los archivos de nuevas fuentes del 
directorio de fuentes de sistema predeterminado y moviendo los archivos antiguos otra vez a ese 
directorio. 

No hay fuentes adicionales en el disco de instalación. Para obtener información acerca de la 
instalación de estas fuentes, consulte http://www.adobe.com/go/learn_fontinstall_es. 

Problemas conocidos 

Consulte Adobe Support para obtener las últimas noticias y problemas conocidos de las 
aplicaciones Creative Suite 4. 

Soporte GB18030 para Windows XP 

• Para poder visualizar todos los caracteres del chino estándar GB18030 en sistemas 
Windows XP, Adobe recomienda la instalación de Microsoft GB18030 Support Package. Este 
paquete de soporte actualizará un sistema XP, entre otras cosas, con fuentes y métodos de 
entrada (IME) para admitir GB18030 correctamente. El paquete de soporte está disponible 
para su descarga desde el sitio Web de Microsoft. (#BG061690) 

Desactivación 

• En Windows, la desactivación puede fallar con el error "No se encuentra Internet" aunque 
haya conexión a Internet. Vaya a Opciones de Internet -> Opciones avanzadas, desmarque 
"Comprobar si se revocó el certificado de servidor” y vuelva a intentar la desactivación. 
(#BG059229) 

Búsqueda de ayuda 

• La búsqueda de ayuda ejecutará Internet Explorer aunque se haya establecido Firefox como 
navegador predeterminado. (#1677521) 

Soundbooth CS4 

• Al hacer doble clic para abrir un archivo ASND guardado en Soundbooth que contenga un 
activo enlazado se mostrará sin conexión la composición/secuencia. Para evitarlo, abra el 
archivo ASND mediante Archivo > Abrir en lugar de hacer doble clic. 

11/9/2008 Léame de Creative Suite 4 Production Premium 7 de 9 
 

http://www.adobe.com/go/learn_fontinstall_es
http://www.adobe.com/go/support_es/


 
 

OnLocation CS4 

• En Windows, si OnLocation se ha instalado en modo de prueba, al hacer clic en el botón 
"Cancelar" en la pantalla de serialización durante la ejecución puede provocar que 
OnLocation se cierre de modo inesperado. Para evitarlo, cierre la pantalla de serialización 
mediante archivo > Cerrar desde el menú Archivo. (#BG070812) 

Asistencia a clientes 

Servicio de atención al cliente 
El servicio de atención al cliente de Adobe proporciona asistencia sobre información de 
productos, ventas, registros y otros problemas no técnicos. Para saber cómo ponerse en 
contacto con el servicio de atención al cliente de Adobe, acceda a la página principal de 
Adobe.com/es y haga clic en Contactar. 

Opciones del plan de asistencia y recursos técnicos 
Si necesita asistencia técnica para su producto o información sobre los planes de asistencia y los 
recursos de solución de problemas gratuitos y de pago, puede consultar la información 
disponible en http://www.adobe.com/go/support_es/. Fuera de Norteamérica, visite 
http://www.adobe.com/go/intlsupport_es/ y haga clic en el nombre de su país. 
 
Entre los recursos de solución de problemas gratuitos se encuentran la base de conocimientos 
de asistencia de Adobe y los foros para usuarios. Continuamente creamos herramientas 
adicionales y ponemos a su disposición información en línea para proporcionarle opciones 
flexibles para solucionar los problemas con la mayor rapidez posible. 

Si tiene problemas con la instalación o desinstalación de alguna aplicación de Creative Suite 4, 
reinicie el sistema antes de ponerse en contacto con el servicio técnico. Para obtener ayuda 
adicional sobre la instalación de CS4, vaya a http://www.adobe.com/go/cs4install_es/. 

 
Otros recursos 

Documentación 
Solicite documentación impresa en http://www.adobe.com/go/buy_books_es/. 

Recursos en línea 
 
Para obtener ayuda completa e instrucciones, inspiración y asistencia técnica comunitaria vaya a 
http://www.adobe.com/go/creativesuite4_community_help_es. 
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También puede ir a Bridge Home: 
Desde cualquier aplicación de Creative Suite 4 seleccione Archivo > Abrir… > Bridge. Una vez 
que Bridge esté abierto, haga clic en el botón Bridge Home en el panel de Favoritos. 
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